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Preface

Welcome to the Oracle Test Manager User Guide. This guide explains how to use
Oracle Test Manager and the Administrator to organize and manage your overall Web
testing process.

This guide is for developers, administrators, managers, QA engineers, and testers who
will be using Oracle Test Manager to track requirements, tests, and issues for testing
projects.

This guide is for the following users:

= Developers who create and debug applications.

= Administrators who setup and manage the database, users, and user roles.
= QA engineers and testers who test and track issues found.

= Project managers who define product or project requirements.

= Managers who review reports on development progress.

Prerequisites

Although no specific technical knowledge is required, some knowledge of test
management and defect tracking is assumed. Administrators should be familiar with
the concepts of user roles and database administration and management.

Using This Guide
This guide is organized as follows:

Chapter 1, "Introduction” provides an overview of Oracle Test Manager.

Chapter 2, "Basics" explains how to install Oracle Test Manager and describes the main
window.

Chapter 3, "Tutorial" provides step-by-step instructions on how to use the basic
features of Oracle Test Manager.

Chapter 4, "Working With Projects” describes how to create and manage projects.

Chapter 5, "Working With Requirements" explains how to create and maintain
requirements.

Chapter 6, "Working With Tests" explains how to create, run, and maintain tests.

Chapter 7, "Working With Issues" explains how to create and maintain issues.



Chapter 8, "Working With Reports" explains how use the Reports and Dashboard tabs
to view, customize, email, and export reports.

Chapter 9, "Configuring Databases" explains how to add, remove, and update
databases to Oracle Test Manager.

Chapter 10, "Administering the Database" explains how to use the Administrator to
maintain project preferences, users, permissions, and project components.

Chapter 11, "Using the Windows Interface" describes the Windows interface to Oracle
Test Manager.

Appendix A, "Screen Capture Utility" describes how to use the Screen Capture utility.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http: //www.oracle.com/support/contact.html or visit
http://www.oracle.com/accessibility/support.html if you are hearing
impaired.

Related Documents

For more information, see the following documents in the Oracle Application Testing
Suite documentation set:

»  Oracle Application Testing Suite Release Notes

»  Oracle Application Testing Suite Getting Started Guide

»  Oracle Functional Testing Functional Testing User’s Guide
»  Oracle Functional Testing Job Scheduler User’s Guide

»  Oracle Functional Testing Navigation Editor User’s Guide



»  Oracle Functional Testing Application Programming Interface Reference
»  Oracle Functional Testing Result Objects Reference

»  Oracle Load Testing Load Testing User’s Guide

»  Oracle Test Manager Test Manager User’s Guide

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

xi
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Introduction

Oracle Test Manager is an easy to use tool that allows you to organize and manage
your overall testing process. It provides a single unified platform for sharing
information among team members.

Oracle Test Manager lets you create projects that group together and organize test
scripts, requirements that need to be tested, and issues resulting from the tests. Once
created, you can indicate the relationships among these items, allowing you to quickly
and easily find all information pertaining to a particular test script, requirement, or
issue.

1.1 Feature Highlights

Oracle Test Manager offers the following features and advantages for integrated
requirements management and defect tracking for both manual and automated tests:

Requirements Management - provides the ability to define and manage requirements
for a specific project. You can specify details for each requirement, track the status of
each requirement, and associate requirements with test cases to ensure testing
coverage.

Test Planning and Management - provides the ability to define and manage a test
plan that incorporates both manual and automated test cases. You can store Oracle
Application Testing Suite scripts in the database, automatically execute scripts in
Oracle Functional Testing from the test plan interface, and automatically store the test
results. You can also associate requirements to test cases to ensure testing coverage,
and associate test cases with issues so they can be reproduced and to keep track of
how the issues were identified.

Defect Tracking - provides the ability to create and manage defects, referred to as
issues, for a specific project. You can associate test cases with issues so they can be
reproduced and to keep track of how the issues were identified.

Integration with Oracle Application Testing Suite - seamlessly integrates with Oracle
Application Testing Suite test solutions, providing the ability to automatically launch
and execute Oracle Functional Testing scripts for functional and regression testing as
well as retrieve and archive the results. You can also launch third party products.

Reporting - generates reports in standard HTML format for managing the overall
testing process. You can report on requirements, tests, and issues.

Administration - provides and administration tool for entering and managing user
accounts, project permissions, and general tool preferences.

Custom Fields - provides the ability to add custom fields to the database for recording
data specific to your projects.

Introduction 1-1
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Database Repository - provides the ability to store test assets including test scripts,
results, attachments, requirements, test plans, and defects in a common database.

1.1.1 Popup Blockers

Popup blockers must be turned off for Oracle Test Manager to operate. To turn off
popup blockers:

Firefox - Select Options from the Tools menu. Uncheck Block Popup Windows.

Internet Explorer - Select Pop-up Blocker from the Tools menu. If the pop-up blocker
is on, select Turn Off Pop-up Blocker.
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Basics

This chapter explains how to install and start Oracle Test Manager. It also describes the
Oracle Test Manager windows, their features, and their menu options. For information
about setting up and using the Windows Interface, refer to Chapter 11, Using the
Windows Interface.

Oracle Test Manager allows you to do the following:

define and manage test plans that incorporate both manual and automated test
cases.

define and manage requirements and issues for a specific project.

automatically launch and execute Oracle Functional Testing scripts for both
functional and regression testing, then retrieve and archive the results.

associate requirements, test cases, and issues within a specific project.
store attachments and view them by launching third party products.

store all test assets including test scripts, results, attachments. requirements, and
issues in a common database.

generate reports for managing the overall test process.

manage user accounts, their permissions and set tool preferences using the Oracle
Test Manager Administrator tool.

2.1 Installing and Starting Oracle Test Manager

To install Oracle Test Manager:

1.

Go to:
http:/ /www.oracle.com/technology/software/products/app-testing/index.html.

Download the Oracle Application Testing Suite product from the Oracle Web site
and save it to a temporary directory on your hard disk.

Unzip the download Zip file and run oats###.exe and follow the setup instructions
to install Oracle Application Testing Suite.

Follow the setup instructions to install the Oracle Application Testing Suite. The
Oracle Application Testing Suite install program will install the WebLogic web
server and the Oracle 10g Express Edition Database by default.

During the Oracle Application Testing Suite installation, you will be required to
enter a default password to be used with Oracle Application Testing Suite
products. Remember this password. It will be required to log in to the Administrator,
Oracle Load Testing, and Oracle Test Manager.
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When the installation is complete, click Programs from the Start menu and then
select Oracle Test Manager from the Oracle Application Testing Suite menu. You
can start the web version or the Windows version. Although the Windows
interface looks slightly different than the web interface, it works the same way as
the web interface. Refer to, Chapter 11, "Using the Windows Interface" for details
on using the Windows interface.

To start Oracle Test Manager from a web server machine type http://server
name:8080/otmorhttp://localhost:8080/otmin the address of a web
browser.

The installation creates a default Administrator user name in the Oracle
Application Testing Suite database. The first time you log into the Administrator,
Oracle Load Testing, or Oracle Test Manager, enter the username Administrator
and the password you defined during the installation. You can use the Oracle
Application Testing Suite Administrator to change the default users and customize
the usernames and passwords for Oracle Application Testing Suite users.

2.2 Changing the Web Server Port

The default Oracle Test Manager web server port is 8088. You can change this to
another port. The port number must be changed in the WebLogic Console and the
Oracle Application Testing Suite configuration.

To change the port in the WebLogic Console:

1.

Gotohttp://localhost:8088/console to start the Oracle WebLogic Server
Administration Console.

Log in as an administrator (the default username is "oats") using the password you
defined during the Oracle Application Testing Suite installation procedure.

In the Domain Structure, select Environment under "oats" and then select Servers.
Select AdminServer(Admin).
Change the port and release the configuration.

See the Oracle WebLogic Server Administration Console documentation for
additional information about using the Console application.

To change the port in the Oracle Application Testing Suite configuration:

6.
7.

8.
9.

10.

2.3 Using SSL

Open the file <installdir>\config\oats-config.xml in a text editor.

Change the port number from 8088 to the new value in all property keys where
the port number is used.

Save the file.
Open the Control Panel and then open Services in the Administrative Tools.

Restart the "Oracle Application Testing Suite Application Service" service.

You can set up Oracle Test Manager to use SSL (Secure Sockets Layer). The procedure
is comprised of the following steps:

1.

Gotohttp://localhost:8088/console to start the Oracle WebLogic
Console.
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3.
4.
5.

Log in as administrator using the password you defined during the Oracle
Application Testing suite installation procedure.

In the Domain Structure, select Environment under "oats" and then select Servers.
Select AdminServer(Admin).
Select the SSL tab.

See the Oracle WebLogic Server documentation for additional information about using
the Console application.

2.4 Setting Up the Web Server

To set up the Web Server:

1.
2

2.5 LoggingIn

Install Oracle Test Manager on the server machine as described previously.

Use Oracle Test Manager Administrator, configure users, projects, and custom
fields as necessary.

Select Oracle Application Testing Suite from the Start menu and then select
Oracle Application Testing Suite Database Configuration from the Tools menu
to configure the database name.

Start the Oracle Test Manager web server on the server machine by selecting
Control Panel from the Start menu and then selecting Services from the Control
Panel Administrative Tools.

Select Oracle Test Manager web-server.
Click Start from the Action menu.

You can set up web server so it will start when you start your machine. Select
Properties from the Action menu.

Click the Recovery tab.

Select Restart the Service in the First failure field.

To log in:

1.

Select Programs from the Start menu and then select Oracle Test Manager - Web
from the Oracle Application Testing Suite menu.

Enter your user name and the password as set by the installation procedure or
your System Administrator.

Select the database you want to access.

Click Login.

2.6 Requirements Tab

The requirements tab lets you work with requirements.

The number of requirements displayed is determined by the number you enter in the
Maximum Tree Nodes field in options. You can:

Expand and collapse the tree view by clicking on the plus and minus signs.
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= View the next or previous group of requirements by clicking the Next or Previous
button.

= Hold the mouse over a node to view a count of its child nodes.

= Move requirements by selecting a requirement and using the move buttons.
= Search requirements by clicking the Find button.

s Group requirements by clicking Group.

= Filter requirements by clicking Filter.

= Toggle between the tree view and grid view by clicking the Tree View and Grid
View buttons.

The color of the icon in front of the requirement indicates its priority. The default
colors are as follows and can be changed by changing the order of the Requirement
Priorities in the Administrator.

= Red, high priority
= Yellow, medium priority
s Green, low priority

The right pane lists the selected requirement's details. In the upper right corner,
associated tests and issues are listed as well as attachments and links. You can:

s Click Edit this requirement to open the Edit Requirement dialog box.
s Click Print to print the right pane.

s Click e-Mail to e-mail the requirement. The title and description are automatically
copied to the e-mail.

s Click on an associated test or issue to view its details.
s Click on an attachment to open it in the appropriate application.
s Click on a link to view the URL in a separate browser window.

s Select Add/Edit to add or edit attachments, links, or associated items.

2.6.1 Right-Click Menu

The right-click menu is displayed when you right-click a requirement in the left pane.
It has the following options:

Add Requirement - displays the Add Requirement dialog box.

Edit Requirement - displays the Edit Requirement dialog box for the selected item.
Delete Requirement - deletes the selected item.

Copy - copies the selected item to the clipboard.

Paste - pastes the contents of the clipboard to the left pane.

Associate Test - displays the Associate Test dialog box.

Attachments - displays the Attach files dialog box.

Group - displays the Group Requirements dialog box for selecting how to sort items in
the left pane.

Filter - displays the Filter Requirements dialog box for selecting which requirements to
show in the left pane.
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2.7 Tests Tab

The tests tab lets you work with tests.

The number of tests displayed is determined by the Maximum Tree Nodes setting in
options. You can:

Expand and collapse the tree view using the plus and minus signs.

View the next or previous group of tests by clicking the Next or Previous button.
Hold the mouse over a node to view a count of its child nodes.

Move tests by selecting the test and using the Move buttons.

Search tests by clicking the Find button.

Group tests by clicking the Group button.

Filter tests by clicking the Filter button.

Schedule when to run tests by clicking the Schedule button.

Toggle between the tree view and grid view by clicking the Tree View and Grid
View buttons.

The icon in front of the test indicates the type of test as follows:

Functional test script - green with a scroll.
Manual test - blue with a pencil.

Test folder - blue with a spiral.

Functional Test group - blue with a plus sign.

3rd Party test - blue with two stars

The color of the icon in front of the test indicates the last result from running the test,
as follows:

Green, passed
Red, failed
Yellow, warning
Blue, not run

Silver, currently running

The right pane lists the selected test's details. Test steps and run history are displayed.
You can:

Click Edit this test to open the Edit Test dialog box.
Click Print to print the right pane.

Click e-Mail to e-mail the test. The title and description are automatically copied
to the e-mail.

Click Run this test to start the Run Manual Test wizard or run an Oracle
Functional Testing test.

Click Delete Results to display the Delete Results dialog box for deleting results
from particular test runs.

For Oracle Functional Testing Tests, click Download Test Script to download the
test script to your machine.
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s Click the date in the Run History section to display result details for a particular
run.

In the upper right corner or the right pane, associated requirements and issues are
listed as well as attachments and links. You can:

s Click on an associated requirement or issue to view its details.
s Click on an attachment to open it in the appropriate application.
s Click on a link to view the URL in a separate browser window.

m  Select Add/Edit to add or edit attachments, links, or associated items.

2.7.1 Right-Click Menu

The right-click menu is displayed when you right-click a test in the left pane. It has the
following options:

Add Test - displays the Add Test dialog box.

Edit Test - displays the Edit Test dialog box for the selected item.

Delete Test - deletes the selected item.

Copy - copies the selected item to the clipboard.

Paste - pastes the contents of the clipboard to the left pane.

Associate Requirements - displays the Associate Requirement dialog box.
Associate Issues - displays the Associate Issue dialog box.

Attachments - displays the Attach files dialog box.

Run test - runs the selected test.

Run branch - runs the selected branch.

Schedule test - displays the New Schedule and Add Task dialog boxes for creating a
schedule. The selected test is automatically added to the tests list.

Set test result - displays the Set Test Result dialog box for setting the test result for the
selected tests to passed, failed, or warning.

Group - displays the Group Tests dialog box for selecting how to sort items in the left
pane.

Filter - displays the Filter Tests dialog box for selecting which tests to display in the
left pane.

2.8 Issues Tab
The issues tab lets you work with issues.

The number of issues displayed is determined by the Maximum Tree Nodes setting in
options. You can:

= View the next or previous group of issues by clicking the Next or Previous button.
s Group issues by clicking the Group button.

»  Filter issues by clicking the Filter button.

= Hold the mouse over a node to view a count of its child nodes.

= Search issues by clicking the Find button.

2-6 Oracle Test Manager - Test Manager User's Guide



Issues Tab

s Toggle between the tree view and grid view by clicking the Tree View and Grid
View buttons.

= Display a particular issue by entering the issue number in the Goto field and
clicking the Goto button.

The color of the icon in front of the issue indicates its priority. The default colors are as
follows and can be changed by changing the order of the Issue Priorities in Oracle Test
Manager Administrator:

= Red, high priority

= Yellow, medium priority

s Green, low priority

The number inside the icon corresponds to the status number.

The right pane lists information about the selected issue including the issue's details,
solution, priority, and status. You can:

s Click Edit this issue to open the Edit Issue dialog box.
s Click Print to print the right pane.

s Click e-Mail to e-mail the issue. The title and description are automatically copied
to the e-mail.

In the upper right corner of the right pane, associated requirements, tests, and issues
are listed as well as attachments and links. You can:

»  Click on an associated test, requirement, or issue to view its details.
s Click on an attachment to open it in the appropriate application.
s Click on a link to view the URL in a separate browser window.

s Select Add/Edit to add or edit attachments or links.

2.8.1 Right-Click Menu

The right-click menu is displayed when you right-click an issue in the left pane. It has
the following options:

Add Issue - displays the Add Issue dialog box.

Edit Issue - displays the Edit Issue dialog box for the selected item.
Delete Issue - deletes the selected item.

Copy - copies the selected item to the clipboard.

Paste - pastes the contents of the clipboard to the left pane.
Associate Test - displays the Associate Test dialog box.

Associate Issues - displays the Associate Issue dialog box.
Attachments - displays the Attach files dialog box.

Group - displays the Group Issues dialog box for selecting how to sort items in the left
pane.

Filter - displays the Filter Issues dialog box for selecting which issues to display in the
left pane.
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2.9 Reports Tab

The Reports tab lets you work with both standard and custom reports.

Oracle Test Manager comes with a standard set of reports that can be viewed as either
a graphic or as data. In addition, you can create custom reports to display only the
data that you are interested in. You can:

= View a standard or custom report by selecting it from the left tree.
= Add a custom report by clicking Add.

= Edit a custom report by clicking Edit.

= Delete a custom report by clicking Delete.

= Clone an existing report to create a copy of it that you can then edit by clicking
Clone.

= Save custom reports by clicking Save.

»  Email reports by clicking Email.

= Print reports by clicking Print.

= Filter the fields in the report to display only the data in which you are interested.
= Export reports to jpg, and xls formats.

Refer to Chapter 5 for instructions on using reports.

2.10 Dashboard Tab

The Dashboard tab lets you view an overview of reports.

One Dashboard reports is available for requirements, tests, and issues. You can
customize which reports are displayed for each and then save the view. In addition,
you can select the number of columns to use for the display.

You can:

= Add reports to the view by clicking Add.

= Remove the selected dashboard report by clicking Delete.
= Save the customized view by clicking Save.

= Print dashboard reports by clicking Print.

»  Toggle the display of the report tree by clicking Toggle.

Each report has the following toolbar with the following options, described from left to
right.

Move Left - moves the report one space to the left.
Move Up - moves the report up one space.

Move Down - moves the report down one space.
Move Right - moves the report one space to the right.
Minimize - minimizes the report.

Maximize - displays the report in a separate window. From there you can toggle
between report and data views, and export the report.

Delete - removes the report from the display.
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2.11 Menu Options

This section lists the Oracle Test Manager menus and options.

2.11.1 Project Menu

The Project menu lets you select which project to open.
Open - displays the Open Project dialog box for selecting the project you want to open.

Import data - displays the Import dialog box for importing a .csv or .xIs file into the
database.

2.11.2 Tools Menu

The Tools menu lets you set user options, configure systems, and view legacy reports.
It has the following options:

Systems - displays the Systems Manager for configuring the systems on which you
will run tests.

Repositories - displays the repositories dialog box for managing repositories.

Options - displays the Options dialog box for setting user preferences.

2.11.3 Help Menu

Contents - displays the table of contents for online help.

About - displays licensing, version, and copyright information.

2.12 Toolbar Options

The toolbar has the following buttons for requirements, tests, and issues:
Refresh - refreshes the tree display.

Add - displays the Add dialog box based on the selected tab.

Edit - displays the Edit dialog box based on the selected item.

Delete - deletes the selected item.

Copy - copies the selected node.

Paste - pastes the last copied node.

Note: Ctrl+C and Ctrl+V are supported for copy and paste.

Schedule - displays the Schedule dialog box for scheduling tests.
Find - displays the Find dialog box for searching requirements, tests, and issues.
History - displays the History dialog box for viewing the history of the selected item.

Move Up - moves the selected item up one spot at its current level. This button is not
available for issues.

Move Down - moves the selected item down one spot at its current level. This button
is not available for issues.
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Outdent - moves the selected item to the same level as its parent. This button is not
available for issues.

Indent - moves the selected item to a submenu of the previous item. This button is not
available for issues.

Group - displays the Group dialog box for selecting how to display the left pane.
Group configurations can be saved and are listed in the drop down list.

Filter - displays the Filter dialog box for selecting the items to display in the left pane.
Filter configurations can be saved and are listed in the drop down list.

Goto - displays the requirement, test, or issue that is entered in the field. Items that are
not listed in the left pane because of the way the pane is filtered, are displayed in the
Temporary Node.

Tree View - changes the display to the tree view.
Grid View - changes the display to the list view.

Next - displays the next group of items based on the Maximum Tree Nodes setting in
options.

Previous - displays the previous group of items based on the Maximum Tree Nodes
setting in options.

The toolbar has the following options on the Reports tab.
Add - displays the Add Report dialog box for adding a custom report.

Edit - displays the Edit Report dialog box for editing the selected custom report.
Standard reports cannot be changed.

Delete - removes the selected custom report. Standard reports cannot be deleted.

Clone - creates a copy of the selected standard or custom report. The copy can then be
edited as needed.

Save - displays the Save Report dialog box for saving custom reports.
Email - displays the Email Report dialog box for emailing the selected report.
Print - displays the Print dialog box for printing the selected report.

Stop - stops loading the report. This is useful when the report is taking a long time to
download.

The toolbar has the following options on the Dashboard tab.

Add - displays the report tree for selecting the report you want to add to the
Dashboard.

Delete - removes the selected report from the display.
Save - displays the Save Dashboard dialog box for saving the dashboard report.
Toggle - toggles the display of the report tree.

2.13 Changing Your User Options

Your user options contain your name, email address, password, and information about
how you want to display items in Oracle Test Manager. If you are an administrative
user, you will have an additional option for resetting test run results.

To change your user options:

1. Select Options from the Tools menu to display the Options dialog box.
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This dialog box has the following options:

User Information - displays options for changing your name and e-mail address.

Database - displays the database that you are logged in to. This field cannot be
changed.

First Name - displays your first name.
Last Name - displays your last name.
E-mail - enter your e-mail address.

Enable E-mail Notification - select this check box to enable e mail notification
when new issues are created or the assigned to field is changed. Notification is
sent to the e-mail address entered in the E mail field.

Tree Preferences - these options let you customize tree behavior.

Maximum Number of Displayed Nodes - enter the maximum number of tree
nodes you want to display.

Display Unique IDs for nodes - when selected, displays each node's unique
ID.

After editing a grouped node, follow the node even if its group changes -
when the tree has been grouped and you edit an item so that its group
changes, the item remains selected in its new location. When this option is not
selected, and you edit an item so that its group changes, the item that was
originally the next item is selected. If there is no next item, the previous item is
selected. If editing the item makes the original parent disappear, then the
top-most parent node is selected.

Include all of the associated nodes while copying a node - when checked,
associated nodes will be copied when copying a node. Otherwise, only the
selected node is copied without any associated nodes.

Change Password - displays the following options for changing your password:

Change - select this check box to change your password.
Old Password - enter the current password.
New Password - enter the new password.

Confirm New Password - re-enter the new password.

Reset Test Runs - this option is only displayed for administrative users.

Reset Test Run Status for all tests - select to change test run status.
Set Result to - enter the new test run status. This field cannot be left blank.

Set Summary to - optionally, enter a comment.

Make any changes.
Click OK.
Click OK.

2.13.1 Resetting Test Run Results

If you are logged on as an administrator you can reset the test run status for all tests in
the project. To reset test run status:

1.

Select Options from the Tools menu to display the Options dialog box.
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2. Select Reset Test Runs.
This dialog box has the following options:
= Reset Test Run Status for all tests - select to change test run status.
= Set Result to - enter the new test run status. This field cannot be left blank.

= Set Summary to - optionally, enter a comment.

3. Select Reset Test Run Status for all tests.
4. Click OK.

5. Enter the new status and a comment.

6. Click OK.

7. Click OK.

2.14 Grouping and Filtering Items

This section explains how to group and filter items in the tree.

2.14.1 Grouping ltems

You can change the order in which requirements, tests, and issues are displayed in the
tree view by changing the way they are grouped. The default view is not grouped, that
is, items are listed in order.

You can optionally save a grouping configuration for use again at a later time. Saved
groupings are listed in the drop down list in the toolbar.

Oracle Test Manager remembers and applies your last grouping selections the next
time you log in.

To group items:

1. Select the tab corresponding to the category you want to group - requirements,
tests or issues.

2. Click Group.
This dialog box has the following options:

Saved groups - lists the saved grouping configurations. To edit or delete a saved
group select it.

Save - displays the Save Criteria dialog box for saving the group settings.
Grouping configurations do not have to be saved.

Delete - deletes the selected saved group.

Group by - select the top level grouping criteria.
Then by - select the second level grouping criteria.
Then by - select the third level grouping criteria.
Then by - select the fourth level grouping criteria.
Apply - applies the settings to the left pane.

3. Select how you want to group items. You can group by default and custom fields
up to four levels.

4. Click Apply to use the settings immediately.
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Click Save to save the settings for later use. The Save Criteria dialog box is
displayed.

Name - enter a name for the grouping. Saved groups are listed in the drop down
list in the toolbar.

Enter a name and click OK.
Click OK.

Click the folder level to display a list of items in the folder. Click the item for
which you want to view details.

2.14.2 Filtering ltems

You can filter the tree view to display only those items in which you are interested.
You can filter by both default and custom fields. Requirements and tests must be
grouped before they can be filtered. Issues can be filtered whether or not they are
grouped.

Filter configurations can be saved for reuse later. Saved filters are listed in the drop
down list in the toolbar.

Oracle Test Manager remembers and applies your last filtering selections the next time
you log in.

To filter items:

1.

Select the tab corresponding to the category you want to filter - requirements, tests
or issues.

Click Filter.
This dialog box has the following options:

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are filtering requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)

<left parenthesis> - select the left parenthesis up to three.
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Field - select the field that you want to use to select the items to display.
Operator

s Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

3. Select how you want to match the criteria. Select all to match all criteria. Select any
to match one criteria. Select a combination to create a filter using a combination of
And and Or.

4. Select or enter the first value by which you want to filter.

L

Select Equals if you want to display items that match the value. Select Not Equal
to if you want to display items that do not match the value.

Select the value to use.
Repeat these steps to filter to additional levels, if required.

Click Apply to immediately apply the filter to the left pane.

© ®» N o

Optionally, click Save to save the filter for reuse. The Save Criteria dialog box is
displayed.

Name - enter a name for the filter. Saved filters are listed in the drop down list in
the toolbar.

10. Enter a name for the filter and click OK.
11. Click OK.

Note: Items that are not displayed are still in the database. To display
the default view set the filter selection to None.

2.15 Using the Grid View

You can display requirements, tests, or issues either in the tree view or in a list view.
The list view lets you view type, owner, status, priority, and date created for multiple
items. The list can be filtered and the items displayed will be based on the filter that is
applied. Grouping options do not affect the display. Click the Grid View button to
switch to this view.

This view is separated into two frames. The top frame lists the items. Clicking on an
item displays its details in the bottom frame. The top frame has the following buttons:

Print - prints the grid view.

First - displays the first item.
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Previous - displays the previous set of items.
Next - displays the next set of items.
Last - displays the last item.

You can click on the line dividing the frames and drag it up or down to resize the
frames.

2.15.1 Sorting the Grid View

You can sort the items in the visible grid by any column in the spreadsheet by clicking
on the title bar of the column you want to use for the sort. The number of items in the
visible grid is determined by the Maximum Number of Displayed Nodes setting in
your profile. To sort the entire database, set this number higher than the number of
items in the database, then sort.
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Tutorial

This tutorial walks you through the main features of Oracle Test Manager. It consists of
the following examples.

= Adding a Requirement - describes how to add a requirement.

= Adding a Test - describes how to add a both a manual and automated test and
how to associate a requirement with a test.

= Running a Test - explains how to run both a manual test and an automated test
and how to view the results of the automated test.

= Adding an Issue - describes how to find and issue, add an issue and associate it
with a test.

s Creating Reports - explains how to view reports and charts.

The tutorial is designed to be followed sequentially from beginning to end. Many of
the examples are interrelated and build upon the steps in previous examples.

3.1 Opening the Sample Project

A demonstration project is installed with Oracle Test Manager for testing the sample
stock brokerage application Fitch & Mather. This application can be viewed at
http://demo. fmstocks. com. To open the sample project:

1. Start Oracle Test Manager and log in.

The default installation user names are Administrator and Default unless
changed by an administrator. The password is the password specified during the
installation procedure unless changed by an administrator.

2. Click Open from the Project menu to display the Open Project dialog box.

3. Make sure the otm-install database is selected. This is the database that was
created when you installed Oracle Test Manager.

4. Select the sample database.
5. Click OK.

The main window is displayed. The left pane contains tabs for the three modules that
comprise the application. They are requirements, tests, and issues. The detailed
information for the selected item is displayed in the right pane. The information
displayed may be different from the examples shown in this tutorial if your system
administrator has customized the database to add new fields or disable default fields.
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3.2 Example 1: Adding a Requirement

This example explains how to add a requirement.

1. Click the Requirements tab.

2. Expand item 1 and click item 1.4. The new requirement will be added as item 1.5.
3. Click Add to display the Add Requirement dialog box.
4

Enter "Users should have access to the chart view of their portfolio" in the Name
field.

o

Select a type, owner, and status.
6. Select Medium from the Priority list.

7. Enter "All customers should be able to view their portfolio in the chart view" in the
Description field.

8. Click Save. The new requirement appears in the tree.

3.3 Example 2: Adding a Test

You can add two types of test cases to Oracle Test Manager:

Manual tests - these are tests that allow you to organize your test cases. For each step
in the test, you enter the action, expected result, and pertinent comments. When you
run the test, the Oracle Test Manager Manual Test Wizard takes you step by step
through the test, allowing you to manually execute each test and enter the result.

Automated tests - these are Oracle Functional Testing tests that can be run
automatically without manual intervention. You can run one test, an entire branch of
tests, or all automatic tests in the project.

This example has two parts. The first part explains how to add a manual test. The
second part explains how to create the same test using Oracle Functional Testing and
add it as an automated test.

3.3.1 Adding a Manual Test

This example explains how to add a manual test.

1. Click the Tests tab.

Click item 1, Login Tests.

Click Add to display the Add Test dialog box.

Enter "Verify customer chart view of portfolio" in the Name field.

Select Manual Test in the Type field.

o a & 0 N

Enter "This test verifies that the chart view of the portfolio is accessible" in the
Description field.

N

Select an owner and priority.

8. Click Save. The test is added as item number 2. You are now ready to add test
steps.

9. Click Add/Edit in the Test Steps section of the right-hand pane to display the Test
Steps dialog box.

10. Click Add.
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11.
12.

13.
14.

Enter, "Go to http:/ /www.fmstocks.com /fmstocks" in the Action field.

Enter, "The FMStocks Customer Login page should be displayed"” in the Expected
Results field.

Click Add to update the top of the dialog box and to go to the next step.
Enter the following steps, clicking Add to start each step:

Step  Action Expected Result

2

Click Login. The Welcome to FMStocks page should be
displayed.

Click the Chart Your The Your Portfolio page should be displayed with a
Portfolio link spreadsheet and graphs.

15.

The Manual Test Steps dialog box shows the entries as entered.

Click OK.

3.3.2 Adding an Automated Test

Oracle Test Manager can run Oracle Functional Testing tests that have been saved in
the Oracle Test Manager Package format. These files have a . otmPKG extension. This
example explains how to create a test in Oracle Functional Testing, add it to the Tests
in Oracle Test Manager, and associate it with the requirement just added.

1.

10.
11.
12.
13.

14.
15.
16.
17.
18.

Select Programs from the Start menu and then select Oracle Functional Testing
from the Oracle Application Testing Suite menu.

Gotohttp://www.fmstocks.com/fmstocks.
Select New Script from the File menu.

Select Record from the Run menu and then select Start to begin recording the
script.

Click Login.
Click the Chart Your Portfolio link.

Select Record from the Run menu and then select Stop to stop recording the
script.

Select Save Script from the File menu.

Navigate to the OracleATS/OFT/Default! workspace.

Select Oracle Test Manager Package (*.otmPKG) as the format to save the file.
Enter ChartPortfolio as the name of the script.

Click Save.

Select Exit from the File menu to exit Oracle Functional Testing and return to
Oracle Test Manager.

Click the Tests tab.

Expand Customer Account Tests and click item 3.3.

Click Add to display the Add Test dialog box.

Enter "Verify customer chart view of portfolio" in the Name field.

Select Oracle Functional Testing Script in the Type field.
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19.
20.
21.
22,

23.
24.
25.

26.
27.
28.
29.

Click Browse in the Test File field.
Select ChartPortfolio.otmPKG.
Select an owner and priority.

Enter "This test verifies that the chart view of the portfolio is accessible" in the
Description field.

Click Save.
The test is added as item 3.4.

Click Add/Edit next to Associated Requirements in the right pane, to display the
Associate Requirement dialog box.

Click the Tree View tab.
Expand item 1 and click item 1.5.
Click Select.

Click OK. The test is now linked to the requirement and is listed on the right-hand
side of the screen. The test is also listed in the Associated Tests section of the
requirement.

3.4 Example 3: Running a Test

This example has two parts. The first part explains how to run the manual test created
in the previous example. The second part explains how to run the automated test
created in the previous example, then how to view the detailed Results Report.

3.4.1 Running a Manual Test

This example explains how to run the manual test entered in the previous example.

1.
2.
3.

6
7.
8.
9

10.

Click the Tests tab and select number 2, Verify customer chart view of portfolio.
Click Run this test in the Run History section of the right-hand pane.

Select 1.0 in the Build field. This is the version number of the application you are
testing.

Click Save.

This dialog box tells you the action to take and the expected result. Open your
browser and perform the first action. Select the result Passed. Enter comments,
when needed, in the Summary field.

Repeat for steps 2 and 3.

Click OK to display the Run Manual Test - Summary window.

Select Passed.

Enter, "No problems encountered with this test." in the Summary field.

Click OK.

The Run History and Result Detail are displayed.
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3.4.2 Running an Automated Test

This example explains how to run an the automated test created in the previous
example and how to view the results detail and the detailed Oracle Functional Testing
Results Report.

1.
2.
3.

Click the Tests tab.
Expand item number 3 and click item 3.4.

Click Run this Test in the Run History section of the right-hand pane to display
the Test run Info dialog box.

Select OTM Server in the System field. This is the machine on which the test will
be run.

Select 1.0 in the Version field. This is the version number of the application you
are testing.

Click Save. Oracle Functional Testing executes the script. Oracle Test Manager
displays the Result Detail Summary when the test is finished.

Click the date of the test in the Run History section of the right pane.

Click View Report in the Result Summary to display the detailed Oracle
Functional Testing Results Report in a separate browser window.

3.5 Example 4: Adding an Issue

This example explains how to search through issues, add an issue, associate it with a
test, and add an attachment with additional information. For the purposes of this
example, we will assume that the script run in example 4 failed.

To search through issues to see if an issue already exists for this topic, or to find related
issues:

1.

2
3
4.
5

Click the Issues tab.

Click Find to display the Find dialog box.
Select Description for the field to search.
Enter the value, "chart."

Make sure that Issues is selected in the Search for field and that all is selected in
the match field. This will search all of the issue descriptions for the word, "chart."

Click Search. If there are any matches they are displayed in the Results portion of
the window.

One match was found. You can click Navigate the Results list to display it in
Oracle Test Manager or click Preview to view the issue in a separate preview
window. We will assume that our failure is different enough to warrant creating a
new issue.

To create an issue.

a & 0N

Click the Issues tab.

Click Add to display the Add Issue dialog box.
Enter "Chart portfolio failed" in the Summary field.
Select the default component.

Select 1.0 for the version.
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12.

13.
14.
15.
16.
17.
18.
19.
20.
21.
22,

Assign the issue to Default User.
Set the status to Created.
Change the Priority to High.
Change the Severity to Medium.

. Select the Windows platform.

. Click Save. The issue is assigned the next available number and added to the

bottom of the list.

Click Add/Edit next to Associated Tests in the right pane to display the Associate
Test dialog box.

Click the Tree View tab.

Expand item 3 and select item 3.4.

Click Select.

Click OK. The test is listed in the Associated Tests list.

Select Add/Edit in the Attachments section to display the Attach Files dialog box.
Click Add.

Click Browse.

Select a file to attach and click Open.

Click Upload.

Click Close. The attachment is listed in the Attachments list in the right pane.
Click on the attachment to open it in the appropriate application.

3.6 Example 5: Creating Reports

Oracle Test Manager comes with a standard set of reports. In addition, you can create
and optionally save custom reports. Reports can be either public, that is, available to
all users, or private, available only to you. This example explains how to view
standard reports and how to create a custom report and save it.

1.

2
3.
4

©® N o o

10.

Click the Reports tab.
Expand the Public Reports node, then the Issues node.
Select Issues by Assigned to Bar Graph to display the graph in the right pane.

Click once on the graph area then mouse over the bars to view the actual values.
Click Data View to view just the data.

To create a custom report click Add.
Enter a name for the report.
Select Vertical bar chart for the report type and 3D for the report template.

Select Priority from the Available fields and click the right arrow to add it to the
Selected fields list.

Click Define filters.

Select Priority as the field, not equal to in the Operator field, and Low for the
Value. This means that the report will only display information for Medium and
High priority requirements.
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11.
12.
13.

14.
15.

Click OK to display the report.

Click Save to save this report.

Enter Requirements Medium and High for the report name. The name will be

displayed in the report tree.
Select My Reports as the Report Category.
Click OK. The new report is added under the My Reports folder.
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Working With Projects

This chapter explains how to maintain projects, use attachments, create links, and view
history.

4.1 Project Basics

A project is the collection of related requirements, tests, and issues grouped together
under a project name.

4.2 Working With Projects

You can open existing projects. Use the Administrator to add new projects.

4.2.1 Adding Repositories

Repositories give you the ability to share files. Any shared directory can be used as a
repository. Since the Oracle Application Testing Suite Application Service runs as the
local SYSTEM user, there may be a policy restricting access to your network share. You
can fix this by doing one of the following;:

Ensure that both sharing permissions and security permission on the remote
network directory allows for other SYSTEM users to gain access. The least
restrictive setting is to allow the windows user "Everyone" to be given permission.

Configure the Oracle Application Testing Suite Application Service to run under a
specific user account rather than the local System user account.

To add a repository:

1.

2.
3.

Select Repositories from the Tools menu.
This dialog box has the following options:
New - adds a new entry to the table.
Delete - deletes the selected repository.
Name - enter the name of the repository.

Path - enter the path of the repository. If the path that you specify is a shared
network drive, the Oracle Load Testing Server must have access to that drive. By
default the Oracle Test Manager Server runs under the "Local System" account.
You may need to change this to run a user account in the Services panel.

Click New. A new entry is made in the table.

Enter the name of the repository.
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4. Enter the location of the repository.

5. Click OK.

4.2.2 Opening Projects
To open a project:
1. Select Open from the Project menu.
This dialog box has the following options:
Project - lists the projects in the selected database.
Database - lists the available databases.

2, Select the database that contains the project you want to open. The projects
displayed are only those in the selected database.

3. Select the project you want to open.

4. Click OK.

4.2.3 Attaching Files to Requirements, Tests or Issues
To attach a file:

1. Select the requirement, test, or issue to which you want to add an attachment.
2. Select Add/Edit from the Attachments section of the right panel.

This dialog box shows a list of files and links in separate sections. A message is
displayed if none have been created. This dialog box has the following options:

File/Link - displays the full path and name of the attachment. Displays the
description or the URL for the link.

Location - displays Database if the attachment was stored in the database,
otherwise displays the path.

Close - closes the dialog box.
Add - displays the Add File dialog box for adding a file or link.

Remove - either removes the reference to the selected attachment or removes the
selected attachment from the database. Attachments are not deleted from the local
machine. Removes the selected link.

Update DB - for attachments stored in the database, updates the selected
attachment, otherwise stores the attachment in the database.

Save Local - for attachments stored in the database, displays the Save As dialog
box for saving the attachment to the local machine.

Edit Link - displays the Update Link dialog box for editing the selected link.
3. (Click Add to display the Add File dialog box.

File - lets you attach a file that will be listed in the Attachments section. Enter the
name and location of the file or click Browse or Capture.

= Browse - displays the Choose File dialog box for selecting the file to attach.

= Capture - lets you capture all or part of the screen and save it as a .jpg or .bmp
file. Once the capture is complete, the Screen Capture utility is displayed.
Select Save As form the File menu to save the file. The name and location is
automatically entered into the File field.
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Entire Screen - captures the entire screen.
Active Window - captures the active window.

Specific Window - captures the window that is displayed after five seconds,
letting you select a window that is not the active window.

Selected Region - lets you select the region to capture.
Link - lets you add a link to the Links section.

»  Title - enter a descriptive title for the link. This will be displayed in the Links
section. This field is required.

»  Link - enter the URL. For example, http: //www. company . com.

Click Browse to attach an existing file. Click a Capture option to start the Screen
Capture utility to capture a screen, save it as a .JPG or .BMP file, and populate the
File Name field. Refer to Appendix A for instructions on using the utility or select
Contents from the Help menu in the utility.

Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the
ScreenCapturelInstall.exe link to download the utility.

Navigate to the file you want to attach and select it.

Click Open.

Uncheck Upload to DB if you do not want to save the attachment in the database.
Click Upload.

Click Close.

4.2.4 Opening Attachments

Attachments are opened in a separate window in their associated application. You can
open attachments that are stored in the database or located on the machine you are
using. You can edit attachments stored in the database. If you do, Oracle Test Manager
asks you if you want to save the changes to the database when you close the window.

To open an attachment:

1.
2.

Select the requirement, test, or issue containing the attachment.

Click the attachment that you want to open in the Attachment section of the right
pane.

4.2.5 Creating Links

You can create a link for requirements, tests, and issues. These links are listed in the
Link section on the right-hand side of the screen. When clicked, the URL is displayed
in a separate browser window. To create a link:

1.
2.

Select the requirement, test, or issue to which you want to add a link.
Select Add/Edit from the Links section of the right panel.

This dialog box shows a list of files and links in separate sections. A message is
displayed if none have been created. This dialog box has the following options:
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File/Link - displays the full path and name of the attachment. Displays the
description or the URL for the link.

Location - displays Database if the attachment was stored in the database,
otherwise displays the path.

Close - closes the dialog box.
Add - displays the Add File dialog box for adding a file or link.

Remove - either removes the reference to the selected attachment or removes the
selected attachment from the database. Attachments are not deleted from the local
machine. Removes the selected link.

Copy to DB/Update DB - for attachments stored in the database, updates the
selected attachment, otherwise stores the attachment in the database.

Save Local - for attachments stored in the database, displays the Save As dialog
box for saving the attachment to the local machine.

Edit Link - displays the Update Link dialog box for editing the selected link.
Click Add to display the Add File dialog box.

File - lets you attach a file that will be listed in the Attachments section. Enter the
name and location of the file or click Browse or Capture.

= Browse - displays the Choose File dialog box for selecting the file to attach.

s Capture - lets you capture all or part of the screen and save it as a .jpg or .bmp
file. Once the capture is complete, the Screen Capture utility is displayed.
Select Save As from the File menu to save the file. The name and location is
automatically entered into the File field.

Entire Screen - captures the entire screen.
Active Window - captures the active window.

Specific Window - captures the window that is displayed after five seconds,
letting you select a window that is not the active window.

Selected Region - lets you select the region to capture.
Link - lets you add a link to the Links section.

»  Title - enter a descriptive title for the link. This will be displayed in the Links
section.

»  Link - enter the URL. For example, http: //www. company . com. If a title is
not entered, the URL is displayed in the links section.

Click Link.
Enter a descriptive title for the link. This will be displayed in the Links section.

Enter the URL for the link. If a title is not entered, the URL is displayed in the
Links section.

Click Upload.
Click Close.

4.2.6 Viewing History

You can view, by date, the history of changes for an individual requirement, test, or
issue. To view history:
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Select the requirement, test, or issue that you want to view.

Click History on the toolbar.

This dialog box has the following options:

Date - lists the dates on which changes were made to the selected item.
<Detail> - displays the details of the selected item as of the selected date.
Select the date you want to view.

Click Close when you are done.

4.2.7 Searching Projects

You can search requirements, tests, and issues based on the value of individual fields.
In addition, you can search all text fields and search for items by creation date.

You can optionally save a search configuration, that is, a filter, for use again at a later
time. Saved filters are listed in the drop down list in the Saved Filters field on the Find
dialog box and are listed in the Filters dropdown on the toolbar so that you can use the
filter to determine what is displayed in the left tree.

Oracle Test Manager remembers and applies your last search selections the next time
you click Find whether or not you saved it.

To search:

1.

Click Find.
This dialog box has the following options:

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - select whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.

Field - select the field that you want to use to select the items to display.
Operator
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s Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - lists the matches.
Navigate - navigates to the selected result and displays it in the right pane.
Preview - shows a preview of the selected result in a separate window.

2. Select the component through which you want to search.

3. Select how you want to match the criteria. Select all to match all criteria. Select any
to match one criteria. Select a combination to create a filter using a combination of
And and Or.

4. Select or enter the first value by which you want to filter.

5. Select Equals if you want to display items that match the value. Select Not Equal
to if you want to display items that do not match the value.

6. Select the value to use.

Note: You can use SQL characters for searching. For example, if you
wanted to find all issues that contained Joe Smith and Mary Jones in
the description field, you could enter %]Joe Smith%Mary Jones% in the
value field.

If you select Creation Date, a calendar icon is displayed to the right of the value
field for selecting a date and two additional operators are available, one for less
than or equal to and one for greater than or equal to.

The calendar has the following options:
dash (-) - toggles the first column displayed between Sun and Mon.
<< and >> - displays the same month in the previous or next year.
< and > - displays the previous or next month.

7. Repeat these steps to filter to additional levels, if required.

8. Optionally, click Save to save the filter for reuse. The Save Criteria dialog box is
displayed.

Name - enter a name for the filter. Saved filters are listed in the drop down list in
the toolbar.

9. Enter a name for the filter and click OK.
10. Click Search.
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11. Double-click on an item in the Results list or click Navigate to display it. Click
Preview to display the item in a separate window.

12. Click Cancel when you are done.

4.2.8 Importing Data

You can import data from either a CSV or XLS file into the current project in the Oracle
Test Manager database for the following types of nodes. Only users with write
permission can import data.

= Requirements

»  Test Cases - both manual tests and test folders can be imported. Test folder child
nodes cannot be imported at the same time as the test folder.

s Issues

s Test run results for manual tests - test step actions cannot be updated. The
expected result can only have a comment added for the run and the actual results
string.

To import data, the columns in the imported file must be matched to the fields in the
database. Oracle Test Manager assumes that the first row in the file being imported
contains labels indicating the type of data in the columns. You can manually map the
columns to the database fields or you can let Oracle Test Manager automatically map
the fields.

Once the fields are mapped, you can choose to save the mappings to a mapping file for
future use so commonly used mappings will not have to be defined each time you
import data. Mapping files are shared across all users.

Records will not be imported if the following conditions occur:

n  For Test Run Results, the test case ID and the number of test steps in t he test case
must match. If there is a mismatch, the records is not imported.

s If a field being imported contains data that is too long for the target field, the
record is not imported.

s If an imported record contains a required field that does not contain data, the
record is still imported but will contain a default value.

The Oracle Test Manager parser expects only the "test step" columns be present in the
rows that represent a test step and all other columns should be empty (i.e. no
whitespace). Errors are logged to the <installdir>\0TM\debugcom. log file on
the installation drive.

If a new item is imported, email notification occurs based on the current rules.

Once you start importing, you can continue working in Oracle Test Manager. The
Import Result dialog box is displayed when importing is finished.

Note: Interrupting the import process by logging out of Oracle Test
Manager, closing the browser window, or stopping the Oracle
Application Testing Suite application Service could result in database
corruption.

To import data:

1. Select Import data from the Project menu to display the Import dialog box.
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This dialog box has the following options:

File Name - enter the file name or click browse to select the CSV or XLS file that
you want to import.

2. Enter a file name or click Browse to locate the file you want to import.
3. Click Upload.

This dialog box has the following options:

Select Type - select the type of data you are importing.

Mappings - you can save mappings set up in this dialog box for use with future
imports.

= Available Mappings - lists saved mapping files. Select a file to apply to the
current import. Click the X to delete the mapping file.

= Save Mappings - when selected a text box is displayed for entering a file name
for the mappings. When you click OK the mappings are saved.

CSV/XLS Column Name - lists the columns in the file you are importing.

Right Arrows - maps the selected column name to the selected database field
name.

Left Arrows - removed the mapping from the selected database field name.

OK - continues the import process and if Save Mappings is selected, creates a
mapping file.

Cancel - cancels the import.
Help - displays help.
Auto Match - creates mapping for column names that match database field names.

4. Select the type of data you are uploading. If you select a mapping file, the type of
data is automatically selected.

5. Match the column labels to the database name fields. You can do this in the
following ways:

= select a mapping file. If the mappings do not match the file being imported an
error message is displayed.

s click the Auto Match button to automatically map column headers to
matching database fields.

= manually select a column label and a database field and click the right arrows
button.

6. Click OK. The Import in progress dialog box is displayed.

7. Click OK. The Import Result dialog box is displayed when importing is finished.
This dialog box has the following options:
Success - displays the number of records that were successfully imported.
Failures - displays the number of records that failed to be imported.

Messages - displays messages about the import.
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Requirements reflect the test plan for the project. Similar requirements can be grouped
together into branches for easy management. Once entered, they can be associated
with the tests that address them.

5.1 Adding Requirements

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

To add a requirement:

1.
2

Select the Requirements tab.

Click Add.

This dialog box has the following options:
Name - enter the name of the requirement.

Type - enter the type of requirement. These options can be changed by your
system administrator.

Owner - select the user that owns the requirement. Only users with read
permission for this project are listed. These options can be changed by your system
administrator.

Status - select the status of the requirement. These options can be changed by your
system administrator.

Priority - select the priority of the requirement. These options can be changed by
your system administrator.

Description - enter additional details about the requirement.

Reset - sets all fields back to their original values.

Attachment - lets you add an attachment or link to this requirement.

File - lets you add an attachment to the Attachments section.

= Browse - displays the Choose File dialog box for selecting the file to attach.

= Capture - starts the Screen Capture utility for capturing a screen, saving it as
either a .JPG or .BMP file, and populating the Attachment field. Refer to
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Appendix A for instructions on using the utility or select Contents from the
Help menu in the utility.

Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the
ScreenCapturelInstall.exe link to download the utility.

Link - lets you add a link to the Links section.

Title - enter a descriptive title for the link. This will be displayed in the Links
section.

Link - enter the URL. For example, http: //www.company . com. If a title is
not entered, the URL is displayed in the links section.

Enter the requirement details.

Click OK.

5.2 Deleting Requirements

To delete one requirement or branch:

1.
2.
3.

Select the requirement or branch that you want to delete.

Click Delete.

Click Yes when asked to confirm the deletion. The requirement and all its sub
requirements are deleted from the database.

To delete multiple requirements:

1.
2.

Select the requirements you want to delete using SHIFI-click and CTRL-click.

Click Delete. The Delete Requirements dialog box is displayed showing the
selected requirements.

Selected nodes - lists the nodes that you selected. Uncheck any nodes that you do
not want to delete.

OK - deletes the selected nodes.

Reset - checks all of the nodes.

Deselect any nodes that you do not want to delete.

Click OK.

5.3 Editing Requirements

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

To edit a requirement:

1.
2

Select the requirement you want to edit.

Click Edit.
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This dialog box has the following options:
Name - enter the name of the requirement.

Type - enter the type of requirement. These options can be changed by your
system administrator.

Status - select the status of the requirement. These options can be changed by your
system administrator.

Owner - select the user that owns the requirement. Only users with read
permission for this project are listed. These options can be changed by your system
administrator.

Priority - select the priority of the requirement. These options can be changed by
your system administrator.

Description - enter additional details about the requirement.
Reset - sets all fields back to their original values.

Make any changes.

Click OK.

5.4 Editing Multiple Requirements

You can edit several requirements at the same time if you want to make the same
change to them all. To edit multiple requirements:

1.
2

N o a 0

Select the requirements you want to edit.
Select Edit Requirement from the right-click menu.

Selected nodes - lists the selected nodes. Deselect nodes that you do not want to
edit.

Fields - the fields listed are determined by the type of node and whether there are
any custom fields.

Check Box - select the check box to change the field's value. The change will be
applied to all of the selected nodes.

Deselect any nodes that you do not want to change.

Select a field that you want to change.

Select or enter the new value. The change will be made to all of the selected nodes.
Repeat for all fields that you want to change.

Click Save.

5.5 Associating Tests With Requirements

There are two ways to associate tests with requirements. You can search for tests that
contain designated values in one or more fields or you can select tests from a tree view.

To associate tests with a requirement using search:

1.
2.

Select the requirement with which you want to associate tests.
Select Add/Edit in the Associated Tests section of the right pane.

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.
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Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.
Field - select the field that you want to use to select the items to display.
Operator

= Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - displays the nodes that match the search criteria.

= Select - places the selected nodes in the Associated Nodes field.

m  Select All - places all nodes in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.

= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

3. Enter the search criteria or select a saved filter and click Search.
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4. Select the tests that you want to associate and click Select or click Select All to

5.

associate all tests that matched the search criteria.

Click OK. The tests are listed in the right pane under associated tests.

To associate tests with a requirement using the tree view:

1.
2.

Select the requirement with which you want to associate tests.
Select Add/Edit in the Associated Tests section of the right pane.

<test list> - double click tests to add and delete them from the list of associated
tests or select the tests you want to add and click Select.

»  Select - places the selected test in the Associated Nodes field.

»  Select All - places all tests in the Results field in the Associated Nodes field.
Associated Nodes - displays the tests that are associated with this requirement.
= Remove - removes the selected test from the Associated Nodes field.

= Remove All - removes all tests from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Select the tests you want associated with this requirement and click Select or click
Select All to associate all tests.

To remove nodes from the Associated Nodes field, select the nodes and click
Remove or click Remove All to remove all nodes.

Click OK. The tests will be listed in the right pane under associated tests.

5.6 Emailing Requirements

You can email a requirement to one or more people. For email to work, the SMTP
server must be configured using the Oracle Test Manager Administrator. To email a
requirement:

1.
2

Click the Requirements tab.
Select the requirement that you want to email and click Email.

Send to - enter the email addresses of the people to whom you want to email this
requirement. Separate email addresses by a comma.

To - displays the Select Email recipients dialog box for selecting recipients from a
list.

Subject - enter the text that you want to appear in the subject of the email. The
default includes the name and id of the requirement.

Message - enter the text that you want to appear in the message.

Enter the recipient email addresses separated by a comma or click To to display
the Select Email Recipients dialog box.

<recipient list> - lists users in you database that have email notification enabled.
Select - adds the selected recipients to the To field.

To - displays the selected recipients separated by a comma.
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4. Select the recipients that you want to receive the requirement and click Select.
Note that only users in your database that have email notification enabled are
listed in the dialog box.

Click Done when you are finished.
Change the subject if necessary.
Enter a message if necessary.

Click OK.

© N o
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Tests can be manual or automatic. Automatic Oracle Functional Testing scripts can be
run from Oracle Test Manager. For manual tests, you enter the individual test steps.
When you run a manual test, a wizard guides you through each step, allowing you to
enter the results.

Tests can be grouped together into branches for easy management. Once entered, they
can be associated with the requirements they address or any issues that result from
running the test.

When you run a test, you can specify the workstation to run it on. Workstations are
configured using the Systems Manager.

In addition, tests can be scheduled to run once at a specified day and time, daily at a
specified time, or weekly at a specified day and time.

6.1 Adding Functional Tests

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

Oracle Functional Testing tests that have been saved as Oracle Test Manager packages
in Oracle Functional Testing can be added from the Web interface. These tests have the
extension .otmPkg. To add an Oracle Functional Testing test:

1. Select the Tests tab.
2. Click the Add button.
3. Enter a name for the test.
4. Select Oracle Functional Testing Script in the Type field.
This dialog box has the following options:
Name - displays the test name.
Type - displays the type of test. The last type selected is displayed first in the last.

= Manual Test - manual tests are entered, performed, and kept track of
manually.

»  Test folder - high level descriptions for grouping tests together.

s Oracle Functional Testing Script - Visual Scripts created using Oracle
Functional Testing.
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»s  Oracle OpenScript - scripts created using Oracle OpenScript.

s Test Group - a list of Oracle Functional Testing tests that are sequentially run
together that can also be scheduled. In addition, the overall results are tracked
and displayed.

= 3rd Party Test - use this option when you want to run an executable file and
capture the results.

Test File - for Oracle Functional Testing tests, displays the Visual Script test file
name. For 3rd Party tests, displays the file that will run. Click Browse to display
the Choose File dialog box for selecting the file.

Owner - select the user that owns the test. Only users with read permission for
this project are listed.

Functionality - for 3rd party tests, displays the regular expression that you want to
match for a result of passed. For all other test types, displays the description of the
functionality the test is designed to verify.

Priority - displays the priority of the test. These options can be changed by your
system administrator.

Description - displays the test description.

Attachment - lets you add an attachment or link to this test.

File - lets you add an attachment to the Attachments section.

= Browse - displays the Choose File dialog box for selecting the file to attach.

= Capture - starts the Screen Capture utility for capturing a screen, saving it as
either a .JPG or .BMP file, and populating the Attachment field. Refer to
Appendix A for instructions on using the utility or select Contents from the
Help menu in the utility.

Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the
ScreenCapturelInstall.exe link to download the utility.

Link - lets you add a link to the Links section.

» Title - enter a descriptive title for the link. This will be displayed in the Links
section.

s Link - enter the URL. For example, http: //www.company . comn. If a title is
not entered, the URL is displayed in the links section.

Reset - clears the fields and returns the dialog box options to the starting state.
5. Click Browse to display the Choose File dialog box.
6. Select the Oracle Test Manager package that you want to add.

7. Select the owner and priority and enter any descriptive information in the
Functionality and Description fields.

8. Click Save.

Once you have added the Oracle Functional Testing test, you can update the page title
and comment fields for individual test steps. In addition, you can add attachments
that are associated with test steps. To update test steps:
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Select Add/Edit in the Test Steps section of the right-hand pane.
First - display the first step.

Previous - displays the previous step.

Next - displays the next step.

Last - displays the last step.

# - displays the step number.

Page Title - displays the page title.

Comment - displays additional information about the step.

Add/Edit Attachments - displays the Add Attachment dialog box for adding an
attachment associated with this test step. Attachments are listed in the Test Steps
section of the right-hand pane.

Select the step that you want to add information to or click Add/Edit Attachments
in the step for which you want to add an attachment.

Enter changes in the Page Title and Comment fields.

Click OK when you are done.

6.2 Adding Oracle OpenScript Scripts

Oracle OpenScript scripts can be added from the Web interface. To add an Oracle

OpenScript test:

1. Select the Tests tab.

2. Click the Add button.

3. Enter a name for the test.

4. Select Oracle OpenScript in the Type field.

This dialog box has the following options:
Name - displays the test name.
Type - displays the type of test. The last type selected is displayed first in the list.

= Manual Test - manual tests are entered, performed, and kept track of
manually.

»  Test folder - high level descriptions for grouping tests together.

s Oracle Functional Testing Script - Visual Scripts created using Oracle
Functional Testing.

= Oracle OpenScript - scripts created using Oracle OpenScript.

»  Test Group - a list of Oracle Functional Testing tests that are sequentially run
together that can also be scheduled. In addition, the overall results are tracked
and displayed.

= 3rd Party Test - use this option when you want to run an executable file and
capture the results.

Repository - for OpenScript scripts, specifies the repository where the script is
located. Click Find to display the Select Script dialog box for selecting the script
file.
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Workspace - for OpenScript scripts, specifies the workspace where the script is
located. When you select a script using Find, the workspace will be filled in
automatically.

OpenScript - specifies the OpenScript script file name. When you select a script
using Find, the script name will be filled in automatically.

Owner - select the user that owns the test. Only users with read permission for
this project are listed.

Functionality - for 3rd party tests, displays the regular expression that you want to
match for a result of passed. For all other test types, displays the description of the
functionality the test is designed to verify.

Priority - displays the priority of the test. These options can be changed by your
system administrator.

Description - displays the test description.

Attachment - lets you add an attachment or link to this test.

File - lets you add an attachment to the Attachments section.

= Browse - displays the Choose File dialog box for selecting the file to attach.

= Capture - starts the Screen Capture utility for capturing a screen, saving it as
either a .JPG or .BMP file, and populating the Attachment field. Refer to
Appendix A for instructions on using the utility or select Contents from the
Help menu in the utility.

Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the
ScreenCapturelInstall.exe link to download the utility.

Link - lets you add a link to the Links section.

»  Title - enter a descriptive title for the link. This will be displayed in the Links
section.

s Link - enter the URL. For example, http: //www.company . con. If a title is
not entered, the URL is displayed in the links section.

Reset - clears the fields and returns the dialog box options to the starting state.
Click Find to display the Select Script dialog box.

Select the Repository and Workspace.

Select the Oracle OpenScript script that you want to add.

Click OK.

Select the owner and priority and enter any descriptive information in the
Functionality and Description fields.

10. Click Save.
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6.3 Adding Manual Tests

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

Tests are automatically numbered when you enter them. You can reorder them using
the Move buttons. To add a manual test:

1.

2
3.
4

Select the Tests tab.

Click the Add button.

Enter the name of the test.

Select the Manual Test in the Type field.
This dialog box has the following options:
Name - displays the test name.

Type - displays the type of test.

= Manual Test - manual tests are entered, performed, and kept track of
manually.

»  Test folder - high level descriptions for grouping tests together.

= Oracle Functional Testing Script - Visual Scripts created using Oracle
Functional Testing.

= Oracle OpenScript - scripts created using Oracle OpenScript.

s Test Group - a list of Oracle Functional Testing tests that are sequentially run
together that can also be scheduled. In addition, the overall results are tracked
and displayed.

= 3rd Party Test - use this option when you want to run an executable file and
capture the results.

Owner - select the user that owns the test. Only users with read permission for
this project are listed.

Functionality - for 3rd party tests, displays the regular expression that you want to
match for a result of passed. For all other test types, displays the description of the
functionality the test is designed to verify.

Priority - displays the priority of the test. These options can be changed by your
system administrator.

Description - displays the test description.

Attachment - lets you add an attachment or link to this test.

File - lets you add an attachment to the Attachments section.

= Browse - displays the Choose File dialog box for selecting the file to attach.

»  Capture - starts the Screen Capture utility for capturing a screen, saving it as
either a .JPG or .BMP file, and populating the Attachment field. Refer to
Appendix A for instructions on using the utility or select Contents from the
Help menu in the utility.
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11.
12.

13.

Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the
ScreenCaptureInstall.exe link to download the utility.

Link - lets you add a link to the Links section.

»  Title - enter a descriptive title for the link. This will be displayed in the Links
section.

s Link - enter the URL. For example, http: //www. company . com. If a title is
not entered, the URL is displayed in the links section.

Reset - clears the fields and returns the dialog box options to the starting state.
Select the owner of the test.

Enter a description of the functionality to be tested.

Select the test priority.

Enter a description of the test.

Click Save.

. Select Add/Edit in the Test Steps section of the right-hand pane.

This dialog box has the following options:

Add - adds a new row under the selected row. When you click the tab key the test
in the Action, Expected Result, and Comment fields is added to the grid. Clicking
Add again also populates the grid.

Delete - deletes the selected step.

Move Up - moves the selected step up one position in the list.
Move Down - moves the selected step down one position in the list.
First - display the first step.

Previous - displays the previous step.

Next - displays the next step.

Last - displays the last step.

# - displays the step number.

Action - displays the action to perform.

Expected Result - displays a description of what is expected to happen as a result
of this step.

Comment - displays additional information about the step.

Add/Edit Attachments - displays the Add Attachment dialog box for adding an
attachment associated with this test step. Attachments are listed in the Test Steps
section of the right-hand pane.

Click Add.

Enter the information in the Action, Expected Result, and Comment fields for the
step. The gird is populated when move to the next field or when you click Add.

Click Add/Edit Attachments to add an attachment associated with this step.

6-6 Oracle Test Manager - Test Manager User's Guide



Adding Test Folder

14. Click Add to add another step or OK to exit the dialog box when you are finished

adding steps.

6.4 Adding Test Folder

Folders are automatically numbered when you enter them. You can reorder them
using the Move buttons. To add a test folder:

1.

2
3.
4

Select the Tests tab.

Click the Add button.

Enter a name for the test.

Select Test Folder in the Type field.

This dialog box has the following options:

Name - displays the test name.

Type - displays the type of test. The last type selected is displayed first in the last.

= Manual Test - manual tests are entered, performed, and kept track of
manually.

»  Test folder - high level descriptions for grouping tests together.

s Oracle Functional Testing Script - Visual Scripts created using Oracle
Functional Testing.

= Oracle OpenScript - scripts created using Oracle OpenScript.

»  Test Group - a list of Oracle Functional Testing tests that are sequentially run
together that can also be scheduled. In addition, the overall results are tracked
and displayed.

= 3rd Party Test - use this option when you want to run an executable file and
capture the results.

Owner - select the user that owns the test. Only users with read permission for
this project are listed.

Functionality - for 3rd party tests, displays the regular expression that you want to
match for a result of passed. For all other test types, displays the description of the
functionality the test is designed to verify.

Priority - displays the priority of the test. These options can be changed by your
system administrator.

Description - displays the test description.

Attachment - lets you add an attachment or link to this test.

File - lets you add an attachment to the Attachments section.

= Browse - displays the Choose File dialog box for selecting the file to attach.

= Capture - starts the Screen Capture utility for capturing a screen, saving it as
either a .JPG or .BMP file, and populating the Attachment field. Refer to
Appendix A for instructions on using the utility or select Contents from the
Help menu in the utility.
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Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the
ScreenCaptureInstall.exe link to download the utility.

Link - lets you add a link to the Links section.

»  Title - enter a descriptive title for the link. This will be displayed in the Links
section.

s Link - enter the URL. For example, http: //www. company . com. If a title is
not entered, the URL is displayed in the links section.

Reset - clears the fields and returns the dialog box options to the starting state.
Enter a description of the functionality of the folder.

Select the owner and priority and enter any descriptive information in the
Functionality and Description fields.

Click Save.

6.5 Adding Functional Tests to a Test Group

Once you have created an Oracle Functional Testing Group, you can add tests to it.
Oracle Functional Testing tests and manual test can be added to an Oracle Functional
Testing group. The same test can be added more than once. The tests in the group are
run sequentially, and the group can also be scheduled. To add tests:

1.
2.
3.

Click the Tests tab.
Select the Oracle Functional Testing Group to which you want to add tests.

In the right pane, click Add/Edit in the Test List area to display the Tests dialog
box. There are two ways you can select tests. You can search for them or select
them from the tree view.

To select tests by searching for them:

1.

Click the Find tab.

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
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2.
3.
4.

use this option. This option lets you select how to group the criteria using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.
Field - select the field that you want to use to select the items to display.
Operator

= Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - displays the nodes that match the search criteria.

= Select - places the selected nodes in the Selected Tests field.

= Select All - places all nodes in the Results field in the Selected Tests field.
Selected Tests - displays the selected nodes.

= <up arrow> - moves the selected test up one place.

= <down arrow> - moves the selected test down one place.

= Remove - removes the selected nodes from the Selected Tests field.
= Remove All - removes all nodes from the Selected Tests field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Enter the search criteria or select a saved filter and click Search.

Select the tests you want to add or click Select All to add them all.
Click OK.

To select tests using the tree view:

1.

Click the TreeView tab.

<test list> - double click tests to add and delete them from the list of selected tests
or select the tests you want to add and click Select.

= Select - places the selected test in the Selected Tests field.
= Select All - places all tests in the Results field in the Selected Tests field.
Selected Tests - displays the selected nodes.

= Remove - removes the selected nodes from the Selected Tests field.
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= Remove All - removes all nodes from the Selected Tests field.
OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Select the tests you want to add or click Select All to add all tests.

To remove nodes from the Selected Tests field, select the nodes and click Remove
or click Remove All to remove all nodes.

Click OK.

6.6 Adding Third Party Tests

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

The 3rd party test lets you run an executable file and capture the results. Before
creating the 3rd party test, create a batch or command file using a text editor such as
Notepad. This file can contain anything that can be run from the command line.

Once you create the test, you can add test steps that use regular expressions to parse
the test output to determine if the test was successful. If all test steps pass, the test
result is passed. If one step fails, the test result is failed.

After the test has run, you can view the console output in the results report. To add a

3rd Party test:

1. Select the Tests tab.

2. C(Click the Add button.

3. Enter a name for the test.

4. Select 3rd Party Test in the Type field.

This dialog box has the following options:
Name - displays the test name.
Type - displays the type of test. The last type selected is displayed first in the last.

= Oracle Functional Testing Script - Visual Scripts created using Oracle
Functional Testing.

= Manual Test - manual tests are entered, performed, and kept track of
manually.

»  Test Folder - high level descriptions for grouping tests together.

s Test Group - a list of Oracle Functional Testing tests that are sequentially run
together that can also be scheduled. In addition, the overall results are tracked
and displayed.

= 3rd Party Test - use this option when you want to run an executable file and
capture the results.

Test File - for Oracle Functional Testing tests, displays the Visual Script test file
name. For 3rd Party tests, displays the file that will run. Click Browse to display
the Choose File dialog box for selecting the file.
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Owner - select the user that owns the test. Only users with read permission for
this project are listed.

Functionality - enter a description of the functionality being tested.

Priority - displays the priority of the test. These options can be changed by your
system administrator.

Description - displays the test description.

Attachment - lets you add an attachment or link to this test.

File - lets you add an attachment to the Attachments section.

= Browse - displays the Choose File dialog box for selecting the file to attach.

= Capture - starts the Screen Capture utility for capturing a screen, saving it as
either a .JPG or .BMP file, and populating the Attachment field. Refer to
Appendix A for instructions on using the utility or select Contents from the
Help menu in the utility.

Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the
ScreenCapturelInstall.exe link to download the utility.

Link - lets you add a link to the Links section.

» Title - enter a descriptive title for the link. This will be displayed in the Links
section.

s Link - enter the URL. For example, http: //www.company . com. If a title is
not entered, the URL is displayed in the links section.

Click Browse to display the Choose File dialog box.
Select the file that you want to run.

Select the owner and priority and enter any descriptive information in the
Functionality and Description fields.

Click Save.
Select Add/Edit in the Test Steps section of the right-hand pane.
This dialog box has the following options:

Add - adds a new row under the selected row. When you click the tab key the test
in the Action, Expected Result, and Comment fields is added to the grid. Clicking
Add again also populates the grid.

Delete - deletes the selected step.

Move Up - moves the selected step up one position in the list.
Move Down - moves the selected step down one position in the list.
First - display the first step.

Previous - displays the previous step.

Next - displays the next step.

Last - displays the last step.

# - displays the step number.
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10.
11.

12.
13.

Action - displays the description of the action.

Result Pattern - displays the regular expression that will be used to parse the
output of the third party test, which will determine if the step passed or failed.
Refer to Appendix B for more information on regular expressions.

Comment - displays additional information about the step.

Add/Edit Attachments - displays the Add Attachment dialog box for adding an
attachment associated with this test step. Attachments are listed in the Test Steps
section of the right-hand pane.

Click Add.

Enter the information in the Action, Result Pattern, and Comment fields for the
step. The gird is populated when move to the next field or when you click Add.

Click Add/Edit Attachments to add an attachment associated with this step.

Click Add to add another step or OK to exit the dialog box when you are finished
adding steps.

6.7 Deleting Tests

You can delete tests from the project. To delete a test or branch:

1.
2
3.

Select the test or branch that you want to delete.
Click the Delete button.

Click Yes when asked to confirm the deletion.

To delete multiple tests:

1.
2

Select the tests you want to delete using SHIFT-click and CTRL-click.
Click Delete. The Delete Tests dialog box is displayed showing the selected tests.

Selected nodes - lists the nodes that you selected. Uncheck any nodes that you do
not want to delete.

OK - deletes the selected nodes.
Reset - checks all of the nodes.
Deselect any nodes that you do not want to delete.

Click OK.

6.8 Editing Tests

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

To edit tests:

1.
2.

Select the test you want to change.
Click Edit.
This dialog box has the following options:

Name - displays the test name.

6-12 Oracle Test Manager - Test Manager User's Guide



Editing Multiple Tests

Type - displays the type of test. The last type selected is displayed first in the last.

s Oracle Functional Testing Script - Visual Scripts created using Oracle
Functional Testing.

= Manual Test - manual tests are entered, performed, and kept track of
manually.

»  Test folder - high level descriptions for grouping tests together.

s Test Group - a list of Oracle Functional Testing tests that are sequentially run
together that can also be scheduled. In addition, the overall results are tracked
and displayed.

Test File - for Oracle Functional Testing tests, displays the Visual Script test file
name. Click Browse to display the Choose File dialog box for selecting the test file.

Owner - select the user that owns the test. Only users with read permission for
this project are listed.

Functionality - displays the description of the functionality the test is designed to
verify.

Priority - displays the priority of the test. These options can be changed by your
system administrator.

Description - displays the test description.
Make any changes.
Click Save.

To edit test step page titles or comments, or to add an attachment to a test step
click Add/Edit in the Test Steps section of the right-pane.

Make any changes.
Click OK.

6.9 Editing Multiple Tests

You can edit several tests at the same time if you want to make the same change to
them all. To edit multiple tests:

1.
2
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Select the tests you want to edit.
Select Edit Test from the right-click menu.

Selected nodes - lists the selected nodes. Deselect nodes that you do not want to
edit.

Fields - the fields listed are determined by the type of node and whether there are
any custom fields.

Check Box - select the check box to change the field's value. The change will be
applied to all of the selected nodes.

Deselect any nodes that you do not want to change.

Select a field that you want to change.

Select or enter the new value. The change will be made to all of the selected nodes.
Repeat for all fields that you want to change.

Click Save.
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6.10 Editing Manual Test Steps

To edit test steps for a manual test:

1.
2.

Select the test for which you want to edit test steps.
Select Add/Edit in the Test Steps section of the right-hand pane.
This dialog box has the following options:

Add - adds a new row under the selected row. When you click the tab key the test
in the Action, Expected Result, and Comment fields is added to the grid. Clicking
Add again also populates the grid.

Delete - deletes the selected step.

Move Up - moves the selected step up one position in the list.
Move Down - moves the selected step down one position in the list.
First - display the first step.

Previous - displays the previous step.

Next - displays the next step.

Last - displays the last step.

# - displays the step number.

Action - displays the action to perform.

Expected Result - displays a description of what is expected to happen as a result
of this step.

Comment - displays additional information about the step.

Add/Edit Attachments - displays the Add Attachment dialog box for adding an
attachment associated with this test step. Attachments are listed in the Test Steps
section of the right-hand pane.

Make any changes.
Click OK.

6.11 Converting Tests

You

can convert manual test case nodes to Oracle Functional Testing test case nodes.

Oracle Test Manager maintains the test case definition and results and allows you to

repl

ace the manual test steps with Oracle Functional Testing scripts. To convert a

manual test:

1.

Select the test you want to convert and click Edit. The Edit Test dialog box is
displayed.

Select Oracle Functional Testing Script in the Type field.
Select the test file that you want to use.

Click OK when asked if you are sure that you want to convert the test type. The
Convert test type dialog box is displayed.

Save a copy of the selected Manual Test Case - saves both the converted test case
and the original test case.

Save the prior results history with the new Oracle Functional Testing Test Case -
saves the prior results history with the new test.

6-14 Oracle Test Manager - Test Manager User's Guide



Configuring Systems

5.
6.

Select the options and click OK.
Click Save.

6.12 Configuring Systems

The Systems Manager lets you configure the systems on which you will be running
tests. When you run or schedule a test, you can specify the workstation on which to
run the test.

6.12.1 Adding Systems

To add a system:

1.
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Select Systems from the Tools menu. The Systems Manager dialog box is
displayed.

New - displays the Systems dialog box for adding a new system.

Edit - displays the Systems dialog box for editing the selected system.
Delete - deletes the selected system.

Name - lists the configured systems.

Click New.

Name - enter the system's name.

Host Name or IP - enter the system's host name or IP address.

Port - enter the port.

Test - attempts to access the system and displays a message stating whether the
system is available.

Enter the system's name.

Enter the system's host name or IP address.
Change the default port, if necessary.

Click Test to see if the system is available.
Click OK to close the test result window.
Click OK.

6.12.2 Editing Systems

To edit a system:

1.

Select Systems from the Tools menu.

New - displays the Systems dialog box for adding a new system.

Edit - displays the Systems dialog box for editing the selected system.
Delete - deletes the selected system.

Name - lists the configured systems.

Select the system that you want to change.

Click Edit.

Name - enter the system's name.
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Host Name or IP - enter the system's host name or IP address.
Port - enter the port.

Test - attempts to access the system and displays a message stating whether the
system is available.

Make any changes.

Click Test to see if the system is available.
Click OK to exit the test result window.
Click OK.

6.12.3 Deleting Systems

To delete a system:

1.

2
3.
4

Select Systems from the Tools menu.
Select the system you want to delete.
Click Delete.

Click Yes when asked to confirm the deletion.

6.13 Running Tests

You can individually run manual tests, Oracle Functional Testing tests, third party, or
Oracle Functional Testing Groups.

6.13.1 Running Functional Tests

To run automated tests:

1.
2.

Select the test you want to run.
Click Run this test in the Run History section of the right pane.
This dialog box has the following options:

System - select the system on which you want to run this test. Systems are
configured using the Systems Manager.

Version - select the version of software you are using or select Other to enter a
version that is not in the list.

Note: If your administrator has created Test Run custom fields, they
will appear in this dialog box.

Select the system on which you want to run the test.

Select the version number against which the test will run and click Save. The
message, "Oracle Functional Testing script execution is in progress," is displayed.
The Oracle Functional Testing Execution dialog box is started. You can maximize
the dialog box to monitor the progress of the test.

This dialog box has the following options:

Oracle Functional Testing Visibility - determines whether Oracle Functional
Testing is visible while the test is running.
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= Visible - Oracle Functional Testing window is visible.
= Invisible - Oracle Functional Testing window is not visible.
Result Set - determines what to do with the test results.

= Show results after the test - displays the Results report in a separate browser
window when the test has finished running.

= Upload results after the test - uploads the results to the Oracle Test Manager
Web interface.

Progress - displays the progress of the test.

Start - starts the test.

Stop - stops the test.

Close - closes the dialog box.

Oracle Functional Testing is started and minimized in the toolbar.

Click Refresh to show the results in the Run History section of the right pane.
Click the date in the Run History field to display result parameters, summary and
detail information. Click View Report in the Result Summary section to view the
Results Report.

6.13.2 Running Manual Tests

To run a manual test:

1.
2.

Select the test you want to run.
Click Run this test in the Run History section of the right pane.
This dialog has the following options:

Version - select the version of the software you are testing or select Other to enter
a version that is not in the list.

Note: If your administrator has created Test Run custom fields, they
will appear in this dialog box.

Enter or select the version number and click Save.

This dialog box appears for each step in the test. It has the following options:
First - displays the first step.

Previous - displays the previous step.

Next - displays the next step.

Last - displays the last step.

Minimize/Maximize - toggles the size of the dialog box.

Start Timer - starts the timer. When the timer is on, it keeps track of how long it
took to run each step and the complete test. The Duration and Iteration Total Time
fields in the Result Detail Section will be populated.

Stop Timer - stops the timer. The Duration field in the Result Detail Section will be
populated for the steps that were completed.
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Make All - sets the result of all steps to the selected status, either Passed, Failed,
Warning, or any user-defined field configured for the Status field in the
Administrator.

Action - displays the action to perform.

Expected Result - displays the expected result.

Comment - displays additional information about the step.
Attachments - lists the attachments associated with this step.
Result - select the outcome of the step after performing it.
Summary - enter additional information about the step.

Add Issue - automatically adds an issue stating that the test had a status of failed
or warning. This option is only available when Failed or Warning is selected.

Save Run - saves the test run status and shows a result of In Progress in the Run
History section for this test run. Click Resume this run to resume testing.

4. Click the Start Timer button if you want Oracle Test Manager to keep track of how
long it takes to complete each step. If you are using the timer the Duration and
Iteration Total Time fields in the Result Detail Section will be populated. If you
stop the timer or save the run only the Duration field will be populated for the
completed steps.

5. Perform each step and select the result or use Make All to set the same result for
each step.

6. Click Save Run to save the results for the completed steps without finishing the
test run or click Finish when you are done. You can continue testing by clicking
Resume this run in the Run History section.

Result - enter the overall outcome of the test.
Summary - enter additional information about the test.

7. Enter the overall test result and any summary comments and click Finish.

6.13.3 Running a Test Group

When you run a Test Group, Oracle Test Manager runs the tests in the group in
sequence.

To run a Test Group:

1. Select the Test Group and click Run this test in the right pane.

2. Select the system on which you want to run this test and click Save.
3. Enter the version number of the software you are testing.

4. The Run Test Group dialog box is displayed for monitoring progress.
5

When all tests are finished, the Group Test dialog box is displayed showing a
summary of the results.

6. Click Close.

6.13.4 Running Third-Party Tests
To run third party tests:

1. Select the test you want to run.
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Click Run this test in the Run History section of the right pane.
This dialog box has the following options:

System - select the system on which you want to run this test. Systems are
configured using the Systems Manager.

Version - select the version of software you are using or select Other to enter a
version that is not in the list.

Note: If your administrator has created Test Run custom fields, they
will appear in this dialog box.

Select the system on which you want to run the test.
Select the version number against which the test will run and click Save.

A message stating that the test is running is displayed. A command line window is
displayed showing the batch file execution.

Click Refresh to show the results in the Run History section of the right pane.

6.13.5 Troubleshooting Third Party Tests

Perform the following steps if the third party test fails to run on the remote machine:

1.

Make sure that the Oracle Load Testing Agent Service is running on the remote
machine.

Check the <installdir>\logs\agentmanager.log file on the remote machine to see if
the agent service started correctly.

Test the communication port between Agent and Oracle Test Manager.

Check the agent manager log file to verify that the JavaAgent . exe was run
when the third party test was started. It is possible to run the same

JavaAgent . exe command line specified in the agentmanager . 1og file from a
DOS console. Verify that the command line argument for the third party test
package URL is correct. If there is no indication that a Java Agent startup request
was issued, verify the Agent version and check the Oracle Test Manager server
log.

If it looks like the Java Agent was started with the correct arguments, look in the
remote machine's <installdir>\logs\agentmananger.log file for any exceptions. It
may help to set the oracle.oats logging category in
<installdir>\agent\log4jJavaAgentDebug.xml file to DEBUG. This will show more
useful third party test execution details. The third party test Java Agent posts its
results over HTTP to a servlet running on the Oracle Test Manager server.

If the agent.log file shows that the third party test ran and that the results were
reported successfully to Oracle Test Manager, then the problem is on the Oracle
Test Manager server side. Look in the Oracle Test Manager server log for
exceptions.

6.14 Setting Test Results

You can set test results for one or more tests. To set test results:

1.
2.

Select the tests for which you want to set results.

Select Set test result from the right-click menu.
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Selected tests - lists the test that you selected. By default, they are selected.
Deselect any tests for which you do not want to set the test result.

Result - select the result that you want to apply to the selected tests.
Version - select the version that you are testing against.

Summary - enter any comments.

Deselect any tests for which you do not want to set the result.

Select the result that you want to apply to the selected tests.

Select the version you are testing against.

Enter any comments in the Summary field.

Click Save.
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6.15 Downloading Test Scripts

You can save Oracle Functional Testing scripts to your local machine. The files are
saved as .otmPkg files. To download a test script:

1. Select the test you want to download.

2. Click Download Test Script in the Run History section of the right pane to display
the File Download dialog box.

Note: If you do not want to display this dialog box in the future,
deselect Always ask before opening this type of file.

3. Click Save to display the Save As dialog box.
4. Select the directory in which you want to save the script and click Save.

5. Click Close when the download is complete.

6.16 Deleting Test Results

You can delete test results based on the date and time the test was run. To delete test
results:

1. Select Delete Results from the Run History section in the right pane.
This dialog box displays a list of test results by date and time.

2. Select the results you want to delete. You can select more than one test result by
clicking on each test result that you want to delete.

3. Click OK.

6.17 Viewing Test Details
You can view the result details for each test run. To view test details:
1. Select the test for which you want to view details.

2. In the Run History section of the right pane, click the date of the test for which you
want to view details.

The details of the test run expand and appear under the Run History section.
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6.18 Viewing the Results Report

The Results report is displayed in a separate browser window and gives detailed
information about the test run. To view the Results report:

1.
2.

Select the test for which you want to view the report.

In the Run History section of the right pane, click the date of the test for which
you want to view the report.

Click View Report in the Result Summary section of the right pane.

6.19 Associating Requirements With Tests

There are two ways to associate tests with requirements. You can search for tests that
contain designated values in one or more fields or you can select tests from a tree view.

To associate requirements with a test using search:

1.
2.

Select the test with which you want to associate requirements.
Select Add/Edit from the Associated Requirements section of the right pane.

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high-priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria, using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.

Field - select the field that you want to use to select the items to display.
Operator

s Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
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<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - displays the nodes that match the search criteria.
= Select - places the selected nodes in the Associated Nodes field.
= Select All - places all nodes in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.
= Remove - removes the selected nodes from the Associated Nodes field.
= Remove All - removes all nodes from the Associated Nodes field.
OK - closes the dialog box and saves changes.
Cancel - closes the dialog box without saving changes.
3. Enter the search criteria or select a saved filter and click Search.

4. Select the requirements you want associated with this test or click Select All to
associate all requirements that matched the search criteria.

5. Click OK. The requirements will be listed in the right pane under associated
requirements.

To associate requirements with a test using the tree view:
1. Select the test with which you want to associate requirements.
2. Select Add/Edit from the Associated Requirements section of the right pane.

<test list> - double click tests to add and delete them from the list of associated
tests or select the tests you want to add and click Select.

= Select - places the selected test in the Associated Nodes field.

»  Select All - places all tests in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.

= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

3. Select the requirements you want associated with this test or click Select All to
associate all requirements that matched the search criteria.

4. To remove nodes from the Associated Nodes field, select the nodes and click
Remove or click Remove All to remove all nodes.

5. Click OK. The requirements will be listed in the right pane under associated
requirements.

6.20 Associating Issues With Tests

There are two ways to associate issues with tests. You can search for issues that contain
designated values in one or more fields or you can select issues from a tree view.

To associate issues with a test using search:
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Select the test with which you want to associate issues.
Select Add/Edit from the Associated Issues section of the right pane.

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high-priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria, using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.

Field - select the field that you want to use to select the items to display.
Operator

s Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - displays the nodes that match the search criteria.

= Select - places the selected nodes in the Associated Nodes field.

= Select All - places all nodes in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.

= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.
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Cancel - closes the dialog box without saving changes.
3. Enter the search criteria or select a saved filter and click Search.

4. Select the issues you want associated with the test and click Select or click Select
All to associate all issues that matched the search criteria.

5. Click OK. The issues will be listed in the right pane under associated issues.
To associate issues with a test using the tree view:

1. Select the test with which you want to associate issues.

2. Select Add/Edit from the Associated Issues section of the right pane.

<test list> - double click tests to add and delete them from the list of associated
tests or select the tests you want to add and click Select.

»  Select - places the selected test in the Associated Nodes field.

»  Select All - places all tests in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.

= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

3. Select the issues you want associated with the test and click Select or click Select
All to associate all issues that matched the search criteria.

4. To remove nodes from the Associated Nodes field, select the nodes and click
Remove or click Remove All to remove all nodes.

5. Click OK. The issues will be listed in the right pane under associated issues.

6.21 Emailing Tests

You can email a test to one or more people. For email to work, the SMTP server must
be configured using the Oracle Test Manager Administrator. To email a test:

1. Click the Tests tab.
2. Select the test that you want to email and click Email.

Send to - enter the email addresses of the people to whom you want to email this
test. Separate email addresses by a comma.

To - displays the Select Email recipients dialog box for selecting recipients from a
list.

Subject - enter the text that you want to appear in the subject of the email. The
default includes the name and id of the test.

Message - enter the text that you want to appear in the message.

3. Enter the recipient email addresses separated by a comma or click To to display
the Select Email Recipients dialog box.

<recipient list> - lists users in you database that have email notification enabled.
Select - adds the selected recipients to the To field.

To - displays the selected recipients separated by a comma.
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Select the recipients that you want to receive the test and click Select. Note that
only users in your database that have email notification enabled are listed in the
dialog box.

Click Done when you are finished.
Change the subject if necessary.
Enter a message if necessary.

Click OK.

6.22 Scheduling Tests

You can schedule Oracle Functional Testing tests to run once on a specified day and
time, daily at a specified time, and weekly at a specified day and time.

6.22.1 Adding Tasks to the Schedule
To add a task to the schedule:

1.

Click the Schedule button or right-click the test you want to schedule and select
Schedule test. If you used the right-click menu, the New Task dialog box is
displayed with the selected test in the Tests field, otherwise, the Schedule dialog
box is displayed.

New Task - displays the New Task dialog box for adding a new task to the
schedule.

System - select the system on which you want to run tasks.

Schedule Area - lists the tasks that are scheduled for the displayed week. The
week is displayed from Sunday to Saturday and defaults to the current week.

s Prev - displays the previous week.

= Next - displays the next week.

= Run Time - displays the time that the task is scheduled to run.

»  Task Name - displays the name of the task.

= Status - displays the task's status.

Task Detail - click on a task name to display details about this task.

= Navigate - displays the test in the right pane of the main window.
»  Preview - displays the test in a separate window.

= Run Now - this button is available for tests that have not been executed. Runs
the test immediately.

= Edit - displays the Edit Task dialog box for changing the task.

= Clone - displays the Edit Task dialog box with the same configuration as the
selected task.

»  Delete - deletes the task from the schedule.

Calendars - shows the current and next month with the displayed week
highlighted. Click on a day in the calendar to display that week.

s Left arrow - moves the calendars back one month.

= Right arrow - moves the calendars forward one month.
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2. Select the day for which you want to schedule a task and click New task in the
Day column or click New task in the top left of the screen.

Name - enter a name for this task.
System - select the system on which you want to run this task.
Description - enter a description of this task.

Start Date - select the date and time at which you want to start this task. Tasks can
be scheduled on the hour, quarter past the hour, on the half our, and quarter to the
hour.

Recurrence - lets you specify when and how often to run this task.

= Run once - runs the task once at the specified date and time.

= Run daily - runs the task every day at the specified time.

= Run weekly - runs the task every week on the specified day and time.

= <days> - these options are only displayed when you select Run weekly. Select
the day on which you want to run the task.

End Date - specify the day on which you want this task to stop running.
Clear Date - blanks out the End Date field.

Conflict rules - specifies what Oracle Test Manager should do when a task is
scheduled to start and another task is still running.

= Wait indefinitely for current task to complete - waits for the running task to
finish before starting the scheduled task.

= Run immediately and abort current task - stops the running task and starts
the scheduled task.

= Wait <minutes> minutes, then abort current task - waits the specified
number of minutes then stops the running task and starts the scheduled task.

Tests - displays the tests that are scheduled.

= Add - displays the Test dialog box for selected tests.

s Delete - deletes the selected test.

= Move Up - moves the selected test up one spot in the list.

= Move Down - moves the selected test down one spot in the list.
Run Parameters

= Version - select the version of software you are testing.

= Send report to - enter the email addresses of the people you want to send the
report to after the schedule is executed or click the To button to display the
Select Email Recipients dialog box for selecting email recipients in your
database that have email notification enabled. Separate email address with a
comma.

Enter a name for the task.
Select the system on which to run the task.

Enter a description of the task.
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Select the start date and time, and how often you want to run the task.
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Select what to do when a task is scheduled to run when another task is still
running.

Click Add to add tests to the task. The same test can be added multiple times.

There are two ways to select tests. You can search for tests that contain designated
values in one or more fields or you can select tests from a tree view.

Find Tab Fields

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high-priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria, using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.

Field - select the field that you want to use to select the items to display.
Operator

= Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> -select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - displays the tests that match the search criteria.

= Select - places the selected tests in the Selected Test field.

= Select All - places all tests in the Results field in the Selected Test field.
Tree View Fields
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<test list> - double click tests to add and delete them from the list of selected tests
or select the tests you want to add and click Select.

»  Select - places the selected test in the Selected Test field.
»  Select All - places all tests in the Results field in the Selected Test field.
Common Fields
Selected Tests - displays the selected tests.
= <up arrow> - moves the selected test up one place.
s <down arrow> - moves the selected test down one place.
= Remove - removes the selected tests from the Selected Test field.
= Remove All - removes all tests from the Selected Test field.
9. Select the Oracle Functional Testing tests that you want to schedule.
10. Click OK.

11. Use the Move Up and Move Down buttons to put the tests in the order in which
you want them to run.

12. Click Save.
13. To test the task, click the task that you want to test, then click Run Now.
14. Click Close to exit the Schedule dialog box.

6.22.2 Editing Tasks

To edit a task:

1. Click the Schedule button.

Click the task that you want to edit. Details about the task are displayed.
Click the Edit button.

Make any changes.

Click Save.

To test the task, click the task that you want to test, then click Run Now.
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Click Close to exit the Schedule dialog box.

6.22.3 Deleting Tasks

To delete a task:

1. Click the Schedule button.

2. Click the task you want to delete.
3. Click Delete.
4

Click Yes when asked to confirm the deletion.
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Working With Issues

Issues keep track of functionality that did not work as expected. Once entered, issues
can be associated with the test that resulted in the issue and other related issues.

7.1 Adding Issues

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

When you add an issue, it is automatically assigned the next available number in the
database and is added at the bottom of the list. This number cannot be changed. You
can group issues by clicking Sort on the toolbar.

To add an issue:

1.
2

Click the Issues tab.

Click Add.

This dialog box has the following options.
Summary - enter the title of the issue.

Component - select the component associated with the issue. Components are
entered by your system administrator using the Administrator.

Version - select or enter the version of the software that was being tested.

Assigned To - select the person responsible for the issue. Only users with read
permission for this project are listed. These options can be changed by your system
administrator.

Status - select the issue's status. These options can be changed by your system
administrator.

Priority - select the issue's priority. These options can be changed by your system
administrator.

Severity - select the severity of the issue. These options can be changed by your
system administrator.

Platform - select or enter the platform on which the issue occurred. These options
can be changed by your system administrator.

Description - enter a new description.
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3.
4,

Solution - enter a new resolution.

Reset - sets all fields back to their original values.

Attachment - lets you add an attachment or link to this issue.

File - lets you add an attachment to the Attachments section.

Browse - displays the Choose File dialog box for selecting the file to attach.

Capture - starts the Screen Capture utility for capturing a screen, saving it as
either a .JPG or .BMP file, and populating the Attachment field. Refer to
Appendix A for instructions on using the utility or select Contents from the
Help menu in the utility.

Note: The utility must be running in your system tray to use this
option. If it is not running, a dialog box is displayed saying that the
program could not be found. Click on the ScreenCapturelnstall.exe
link to download the utility.

Link - lets you add a link to the Links section.

Title - enter a descriptive title for the link. This will be displayed in the Links
section.

Link - enter the URL. For example, http: //www.company . com. If a title is
not entered, the URL is displayed in the links section.

Enter the issue details.

Click OK.

7.2 Deleting Issues

To delete one issue:

1.
2.
3.

Select the issue you want to delete.

Click Delete.

Click Yes when asked to confirm the deletion.

To delete multiple issues:

1.
2.

Select the issues you want to delete using SHIFT-click and CTRL click.

Click Delete. The Delete Issues dialog box is displayed showing the selected
issues.

Selected nodes - lists the nodes that you selected. Uncheck any nodes that you do
not want to delete.

OK - deletes the selected nodes.

Reset - checks all of the nodes.

Deselect any nodes that you do not want to delete.

Click OK.
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7.3 Editing Issues

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

To edit an issue:

1.

Select the issue you want to edit.
This dialog box has the following options.
Summary - enter the title of the issue.

Component - select the component associated with the issue. Components are
entered by your system administrator using The Administrator.

Version - select or enter the version of the software that was being tested.

Assigned To - select the person responsible for the issue. Only users with read
permission for this project are listed. These options can be changed by your system
administrator.

Status - select the issue's status. These options can be changed by your system
administrator.

Priority - select the issue's priority. These options can be changed by your system
administrator.

Severity - select the severity of the issue. These options can be changed by your
system administrator.

Platform - select or enter the platform on which the issue occurred. These options
can be changed by your system administrator.

Description - enter a new description.

Edit Text - select this option to edit previously entered description text. The text is
displayed when the box is checked.

Solution - enter a new resolution.

Edit Text - select this option to edit previously entered solution text. The text is
displayed when the box is checked.

Reset - sets all fields back to their original values.
Click Edit.

Make any changes.

Click OK.

7.4 Editing Multiple Issues

You can edit several issues at the same time if you want to make the same change to
them all. To edit multiple issues:

1.
2.

Select the issues you want to edit.
Select Edit Issue from the right-click menu.

Selected nodes - lists the selected nodes. Deselect nodes that you do not want to
edit.
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Fields - the fields listed are determined by the type of node and whether there are
any custom fields.

Check Box - select the check box to change the field's value. The change will be
applied to all of the selected nodes.

Deselect any nodes that you do not want to change.

Select a field that you want to change.

Select or enter the new value. The change will be made to all of the selected nodes.
Repeat for all fields that you want to change.

Click Save.

7.5 Associating Issues With Issues

There are two ways to associate issues with issues. You can search for issues that
contain designated values in one or more fields or you can select issues from a tree
view.

To associate issues with an issue using search:

1.
2

Select the issue with which you want to associate issues.
Select Add/Edit from the Associated Issues section of the right pane.

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high-priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria, using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.
Field - select the field that you want to use to select the items to display.
Operator

= Equals - causes only items that match the value for the selected field to be
displayed.
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5.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - displays the nodes that match the search criteria.

= Select - places the selected nodes in the Associated Nodes field.

= Select All - places all nodes in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.

= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Enter the search criteria or select a saved filter and click Search.

Select the issues you want associated with this issue and click Select or click Select
All to associate all issues that matched the search criteria.

Click OK. The issues will be listed in the right pane under the associated issues.

To associate issues with an issue using the tree view:

1.
2.

Select the issue with which you want to associate issues.
Select Add/Edit from the Associated Issues section of the right pane.

<test list> - double click tests to add and delete them from the list of associated
tests or select the tests you want to add and click Select.

»  Select - places the selected test in the Associated Nodes field.

»  Select All - places all tests in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.

= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Select the issues you want associated with this issue and click Select or click Select
All to associate all issues that matched the search criteria.

To remove nodes from the Associated Nodes field, select the nodes and click
Remove or click Remove All to remove all nodes.

Click OK. The issues will be listed in the right pane under the associated issues.
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7.6 Associating Tests With Issues

There are two ways to associate tests with issues. You can search for tests that contain
designated values in one or more fields or you can select tests from a tree view.

To associate tests with an issue using search:

1.
2.

Select the issue with which you want to associate tests.
Select Add/Edit from the Associated Tests section of the right pane.

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.
Search for - displays whether you are searching requirements, tests, or issues.
that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high-priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria, using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
<left parenthesis> - select the left parenthesis up to three.
Field - select the field that you want to use to select the items to display.
Operator

s Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

Results - displays the nodes that match the search criteria.
= Select - places the selected nodes in the Associated Nodes field.

= Select All - places all nodes in the Results field in the Associated Nodes field.
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5.

Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.
= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Enter the search criteria or select a saved filter and click Search.

Select the tests you want associated with the issue and click Select or click Select
All to associate all tests that matched the search criteria.

Click OK. The tests will be listed in the right pane under associated tests.

To associate tests with an issue using the tree view:

1.
2.

Select the issue with which you want to associate tests.
Select Add/Edit from the Associated Tests section of the right pane.

<test list> - double click tests to add and delete them from the list of associated
tests or select the tests you want to add and click Select.

»  Select - places the selected test in the Associated Nodes field.

»  Select All - places all tests in the Results field in the Associated Nodes field.
Associated Nodes - displays the selected nodes.

= Remove - removes the selected nodes from the Associated Nodes field.

= Remove All - removes all nodes from the Associated Nodes field.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Select the tests you want associated with the issue and click Select or click Select
All to associate all tests that matched the search criteria.

To remove nodes from the Associated Nodes field, select the nodes and click
Remove or click Remove All to remove all nodes.

Click OK. The tests will be listed in the right pane under associated tests.

7.7 Emailing Issues

You can email a issue to one or more people. For email to work, the SMTP server must
be configured using the Administrator. To email a issue:

1.
2

Click the Issues tab.
Select the issue that you want to email and click Email.

Send to - enter the email addresses of the people to whom you want to email this
issue. Separate email addresses by a comma.

To - displays the Select Email recipients dialog box for selecting recipients from a
list.

Subject - enter the text that you want to appear in the subject of the email. The
default includes the name and id of the issue.

Message - enter the text that you want to appear in the message.
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3. Enter the recipient email addresses separated by a comma or click To to display
the Select Email Recipients dialog box.

<recipient list> - lists users in you database that have email notification enabled.
Select - adds the selected recipients to the To field.
To - displays the selected recipients separated by a comma.

4. Select the recipients that you want to receive the issue and click Select. Note that
only users in your database that have email notification enabled are listed in the
dialog box.

Click Done when you are finished.
Change the subject if necessary.
Enter a message if necessary.

Click OK.

© N o
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Working With Reports

Oracle Test Manager contains two tabs for viewing and creating reports. The Reports

tab lets you access standard reports and create your own custom reports that you can
either keep private or make available to all Oracle Test Manager users. Reports can be
saved, emailed, and exported to various formats.

Note: The standard reports that are available is configured by your
administrator so that not all reports may be available to all users.

The Dashboard tab displays a high-level view of several reports. The reports that are
displayed on this tab can be customized and the view can be saved. These reports can
be enlarged into a separate window and then exported to various formats.

8.1 Viewing Reports

To view reports:

1. Click the Reports tab.

2. Expand the node containing the report that you want to view.
3. Select the report. It is displayed in the right pane.
4

In the Report View, click once on the chart to activate it. You can mouse over the
chart or graph to view the value of each slice or bar. Tables do not have a report
view.

5. Click the Data View tab to view the data in a table.

8.2 Adding Custom Reports

You can add a custom report that can optionally be saved. Custom reports can be
designated as either public, that is, available to all users, or private, available only to
you.

To add a custom report:
1. Click the Reports tab.
2, Click Add. The Add Report dialog box is displayed.

Define report - this node lets you define the type of report that you want and the
fields that you want to display in it.

Report title - enter a title for the report. The title is displayed in the right pane and
in the report tree.
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Report category - this field is only displayed when you are editing a report. Select
whether the report is to be public or private.

Public Reports - the report is available to all users under the Public Reports
node in the location that you select.

My Reports - the report is available only to you. It is listed under My Reports
or another node that you create.

<location> - select where to save the report. The categories listed are those
that are available under the Public Reports or My Reports nodes. Click New to
create a new category.

Report on - select the type of data you want to report on, requirements, tests,
issues, or test steps.

Report type - select the type of report you want to display. Click on the question
mark icon to display a sample of the selected report type.

Vertical bar chart - displays a vertical bar chart of the selected fields.
Horizontal bar chart - displays a horizontal bar chart of the selected fields.
Pie Chart - displays a pie chart of the selected fields.

Cross tab - displays a spreadsheet of the selected fields.

Text Report - displays a text report of the selected fields.

Trend Report - this report shows the total number of items in a specific status
(or other option list field) by week, day, or month, over the specified date
range.

Special table report - this option is automatically selected when you are
reporting on test steps.

The following fields are displayed for vertical bar charts, horizontal bar charts,
and pie charts:

Available fields - lists the fields that are available for the type of data you are
reporting on.

<right arrow> - adds the selected fields to the Selected fields list.
<left arrow> - removes the selected fields from the Selected fields list.

Selected fields - shows the fields that will be include in the report.

The following fields are displayed for cross tab reports:

Available fields - lists the fields that are available for the type of data you are
reporting on.

<right arrow> - adds the selected fields to the Selected fields list.
<left arrow> - removes the selected fields from the Selected fields list.
Rows - shows the fields that will be displayed in the rows of the report.

Columns - shows the fields that will be displayed in the columns of the report.

The following fields are displayed for text reports:

Available fields - lists the fields that are available for the type of data you are
reporting on.

<right arrow> - adds the selected fields to the Selected fields list.

<left arrow> - removes the selected fields from the Selected fields list.
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= Selected fields - shows the fields that will be include in the report.
= Sort By - shows the fields that will be used to sort the report.
The following fields are displayed for trend reports:

= Start date - select the date on which you want to start reporting by clicking on
the calendar icon.

= End date - select the date on which you want to end reporting by clicking on
the calendar icon.

s Trend by - select how you want to trend the data, day, week, or month.

s Trend of - select the field that you want to show the trend of. The fields vary
depending on the data you are reporting on.

= Select Trend options - select the option on which you want to trend. The
options are based on what you selected in the Trend of field.

The following fields are displayed for test step reports:

= Available Test fields- lists the fields that are available for tests.

»  <right arrow> - adds the selected fields to the Selected fields list.

»  <left arrow> - removes the selected fields from the Selected fields list.

»  Selected Test fields - shows the fields that will be include in the report.

= Available TestStep fields - lists the fields that are available for test steps.

»  Selected TestStep fields - shows the fields that will be include in the report.

If you want to further filter the data you are including in the report, click Define
filters.

Saved filters - lists the saved filter configurations. Select a saved filter to edit or
delete it.

Save - displays the Save Criteria dialog box for saving the settings. Filters do not
have to be saved.

Delete - deletes the selected saved filter.

Search for - select whether you are searching requirements, tests, or issues. If you
are filtering a report, this fields defaults to the type of data you are reporting on
and cannot be changed.

that match - select how to apply the filtering criteria.

= all - match all of the configured criteria. This setting places an AND between
the criteria. For example, if you wanted to view all issues with a high priority
that are assigned to you, use this option.

= any - match any of the configured criteria. This setting places and OR between
the criteria. For example, if you wanted to view all issues with either a high
priority or a high severity, use this option.

= acombination - this setting lets you combine AND and OR. For example, if
you wanted to view all issues assigned to Mary or Caren with a high priority,
use this option. This option lets you select how to group the criteria using
parenthesis as required. For example:

(((Assigned to = Mary OR Assigned to = Caren) AND Priority = High) OR
Severity = High)
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10.
11.

<left parenthesis> - select the left parenthesis up to three.
Field - select the field that you want to use to select the items to display.
Operator

s Equals - causes only items that match the value for the selected field to be
displayed.

= Not Equal to - causes only items that do not match the value for the selected
field to be displayed.

= <= - this option is only available when Creation date is the selected field. It
causes items less than or equal to the selected date value to be displayed.

= >=- this option is only available when Creation date is the selected field. It
causes items greater than or equal to the selected date value to be displayed.

Value - enter or select the value of the field that you want to use to select the items
to display.

<right parenthesis> - select the right parenthesis up to three.
<operator> - select the operator to use, AND or OR.
<delete> - deletes the corresponding criteria.

<expression> - shows the filtering expression you are creating as you select
criteria.

If you select Creation Date, a calendar icon is displayed to the right of the value
field for selecting a date. Click on the calendar icon to display the calendar. The
calendar has the following options:

dash (-) - toggles the first column displayed between Sun and Mon.
<< and >> - displays the same month in the previous or next year.
< and > - displays the previous or next month.

Select how you want to match criteria. Select all to match all criteria. Select any to
match one criteria. Select a combination to create a filter using a combination of
And and Or.

Select or enter the first value by which you want to filter.

Select Equals if you want to display items that match the value. Select Not Equal
to if you want to display items that do not match the value.

Select the value to use.

Note: You can use SQL characters for searching. For example, if you
wanted to find all issues that contained Joe Smith and Mary Jones in
the description field, you could enter %]Joe Smith%Mary Jones% in the
value field.

Repeat these steps to filter to additional levels, if required.

Optionally, click Save to save the filter for reuse. The Save criteria dialog box is
displayed.

Enter a name for the filter and click OK.

Click OK. The report is displayed in the right pane. The report is listed in the
Report tree as not saved.
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12.

13.
14.

15.

Click Save if you want to keep the report for future use or make it available to
other users. The Save Report dialog box is displayed.

Report name- enter a name for the report. This is the name that will appear in the
report tree.

Report category - select whether the report is to be public or private.

»  Public Reports - the report is available to all users under the Public Reports
node in the location that you select.

= My Reports - the report is available only to you. It is listed under My Reports
or another node that you create.

<location> - select where to save the report. The categories listed are those that are
available under the Public Reports or My Reports nodes. Click New to create a
new category.

Report Details - lists the type of report and the data that is being reported on.
Enter a name for the report. This is the name that will appear in the report tree.

Select the category in which to save the report. Select New to create a new
category.

Click OK.

8.3 Editing Custom Reports

Only custom reports that have been saved can be edited. To edit a report:

1.

2
3
4.
5

Click the Reports tab.

Select the custom report that you want to edit and click Edit.

Make any changes to the report definition, report location, or the report filters.
Click Apply.

Click OK.

8.4 Cloning Reports

Cloning a report is useful when there is an existing report that is close to what you are
looking for. You can clone it, that is, make a copy of it, and then edit it to your
specifications. To clone a report:

1.
2.

o o & W

Click the Reports tab.

Select the report that you want to clone and click Clone. The report is copied and
saved at the end of its original category with the words Copy of in front of the
report name.

Click Edit to display the Edit Report dialog box.

Make any changes to the report definition, report location, or the report filters.
Click Apply.

Click OK.
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8.5 Deleting Reports

Only custom reports that have been saved can be deleted. Custom reports that have
not been saved will not be available the next time you log in. To delete a report.

1. Click the Reports tab.
2. Click the custom report that you want to delete and click Delete.

3. Click Yes when asked to confirm.

8.6 Emailing Reports

You can email a report to one or more people. For email to work, the SMTP server
must be configured using the Oracle Test Manager Administrator. Refer to
Section 10.4, "Configuring Email Preferences"for more information.

To email a report:
1. Click the Reports tab.
2. Select the report that you want to email and click Email.
Selected Report - displays the name of the report you are emailing.

Send to - enter the email addresses of the people to whom you want to email this
report. Separate email addresses by a comma.

To - displays the Select Email recipients dialog box for selecting recipients from a
list.

Subject - enter the text that you want to appear in the subject of the email. The
default is the name of the report.

Attach as - select the format in which you want to attach the report, pdf or jpeg.
Message - enter the text that you want to appear in the message.

3. Enter the recipient email addresses separated by a comma or click To to display
the Select Email Recipients dialog box.

<recipient list> - lists users in you database that have email notification enabled.
Select - adds the selected recipients to the To field.
To - displays the selected recipients separated by a comma.

4. Select the recipients that you want to receive the report and click Select. Note that
only users in your database that have email notification enabled are listed in the
dialog box.

Click Done when you are finished.

Change the subject if necessary.

Select the file type in which you want the report to be sent.
Enter a message if necessary.

Click OK.
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8.7 Viewing Dashboard Reports

There are three default dashboard reports, one for requirements, one for issues, and
one for tests. You can rearrange the order of the reports, add or remove reports to the
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display, and save your changes. You can also create new dashboard reports as
described later in this chapter. To view a dashboard report:

1.

2
3
4.
5

@

8.
9.

Click the Dashboard tab.

Select the dashboard report that you want to view.

Select the number of columns to display.

Move the reports in the display using the arrows in the toolbar.

Click Toggle to display the report tree for adding a report to the display. Double
click the report that you want to add to the display.

Click the Toggle button to close the report tree.
Click Save to display the Save Dashboard to save your changes.
Dashboard name- enter a name for the dashboard report.

Dashboard type - select the type of dashboard report. Public dashboards are listed
first in the dashboard dropdown, followed by the private dashboards.

s Public dashboards - select this option to make this dashboard report available
to all users.

= My dashboards - select this option to make this dashboard available only to
you.

Enter a new name for the Dashboard report, if necessary.

Select the type of dashboard report.

10. Click OK.

8.8 Adding Dashboard Reports

To add a dashboard report:

1.
2

N o a 0

Click Add on the Dashboard tab.

The report tree is displayed with a blank report on the right. Expand the report
tree and double-click on the reports that you want to add. They will be displayed
in the right pane as shown in the following example.

Click Toggle to close the report tree.

Click Save to save the new dashboard report.
Enter a name for the dashboard report.

Enter a title for the dashboard report.

Select whether you want to make this report available to all users or just to
yourself.

Click OK.

8.9 Deleting Dashboard Reports

To delete a dashboard report:

1.

2.

Select the dashboard report that you want to delete from the dashboard dropdown
list.

Click Delete.
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3. C(lick Yes when asked to confirm.

8.10 Exporting Reports

Reports can be exported from the Reports tab and the Dashboard tab. You can export
to jpg from the Report View tab. You can export to xlIs from the Data View tab. To
access the Report View and Data View tabs from the Dashboard report, maximize the
report that you want to export.

8.10.1 Exporting to JPG
To export to jpg:

1. Click the Report View tab of the report that you want to export.
2. Click Export report to jpg. The report is displayed in a separate window.

3. Either right-click the report and select Save Picture As, or mouse over the report
and click the Save button on the toolbar. The Save Picture dialog box is displayed.

4. Select the folder in which you want to save the file.

5. Enter a name for the file and click Save.

8.10.2 Exporting to XLS

To export to xls:
1. Click the Data View tab of the report that you want to export.

2. Click Export to xIs. The data is displayed in a separate browser window.
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Configuring Databases

This chapter explains how to add and remove databases from Oracle Test Manager,
and how to update name, location, and login information for databases that you are
using in Oracle Test Manager.

9.1 Adding Databases

You can add an existing Oracle Database 11¢ Enterprise Edition, 10g Enterprise
Edition, or 10g Express Edition database for Oracle Test Manager and Oracle Load
Testing or you can create a new schema. In addition, you can create tables in an empty
database. When you add a database, the Database Configuration Utility creates a user
account for the default user and the administrator. Use Oracle Test Manager
Administrator to add more users and to customize projects.

Note: If you are re-installing Oracle Test Manager and intend to use
the same database after reinstallation, you must remove the database
name from the System DSN registry before configuring the database
for use in Oracle Test Manager. Do this in the ODBC Data Source
Administrator by selecting Control Panel from the Start menu and
open Data Sources (ODBC) in the Administrative Tools. Select the
database name on the System DSN tab and click Remove.

9.1.1 Adding a Database

To add an Oracle database or configuration schema:

1.

Select Programs from the Start menu then select Oracle Application Testing Suite
Database Configuration from the Oracle Application Testing Suite - Tools menu.

Select the type of database to add: Oracle Test Manager, Oracle Load Testing, or
Configuration schema.

Click New.
Select Use existing schema or Create new schema & tables.
This dialog box has the following options:

Use existing schema - when selected, a database is added using an existing Oracle
database schema.

Create new schema & tables - when selected, a database is added using an new
Oracle database schema and tables.
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System user credentials - specify the login authentication credentials if you select
to create a new schema and tables, as follows:

s User name - enter the login user name for the database system.
s Password - enter the login password for the database system.
Connection details - enter the Oracle database connection information.

= Name - enter the name of the database This name appears in the database
selection lists for Oracle Test Manager and as the ODBC Data Source name.

s Description - enter any description text to identify the database.

s Host - enter the host name of the machine on which the database server is
running.

s Port - enter the port number that you want to communicate with. If you are
running multiple instances of Oracle Database on the same host, specify the
port number you want to communicate with.

= Service - enter the Service name for the Oracle database.
= User name - enter the login user name for the database.
= Password - enter the login password for the database.

= Tablespace - the tabespace name. When creating a new configuration schema
and tables, you can choose to create a new user on the database or use an
existing user. If creating a new user, provide a tablespace name where the user
will be created. The "USERS" tablespace will be used as default.

Options - select options, as follows:

s Insert sample data - when selected, the sample data is installed into the new
database. For Oracle Test Manager, the sample data is the Sample Project used
for the tutorial. For Oracle Load Testing, the sample data is the two load
sessions that can be used to generate sample reports.

5. Enter the database connection details. If you selected Create new schema &
tables, enter the System user credentials and the Tablespace name.

6. Click Save.

7. Click Close. When you add a new connection for an Oracle Load Testing database
or a new Configuration schema, the new database is not automatically set as the
default connection. Select the database in the Database Connections list and click
the Set current toolbar button if you want the new connection to be the current
database connection.

8. [Either restart the computer or restart the Oracle Application Testing Suite
Application service by going to the Control Panel Administrative Tools and open
Services and restart the Oracle Application Testing Suite Application Service.

9.2 Removing Databases

You can remove databases from Oracle Test Manager. Doing so does not delete the
database files. It removes the database from the database selection lists so that the
database is no longer available in Oracle Test Manager. The database cannot be deleted
if it is open in Oracle Test Manager.

To remove a database from Oracle Test Manager:
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1. Select Programs from the Start menu then select Oracle Test Manager Database
Configuration from the Oracle Application Testing Suite - Tools menu.

2. Select the database that you want to remove.
3. Click Remove.

4. Click Yes to confirm the deletion.

9.3 Updating Databases

You can change the name, location, and login information for databases that you are
using in Oracle Test Manager.

1. Select Programs from the Start menu then select Oracle Test Manager Database
Configuration from the Oracle Application Testing Suite - Tools menu.

Select the database that you want to update.
Click Update.

Make any changes.

Click OK.

a & 0N
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Administering the Database

The Administrator allows the system administrator to manage users, roles, projects,
and fields.

10.1 Starting the Administrator

A default administrator account is created when Oracle Test Manager is installed. The
username is Administrator and the password is the password specified during the
installation procedure. It is recommended that you change the password as soon as
you log in.

To start the Administrator:

1. Select Programs from the Start menu and then select Administrator from the
Oracle Application Testing Suite menu.

2. Enter your password.
3. Select the Oracle Test Manager database that you want to access.

4, If this is the first time you are logging in, change the administrator password by
clicking the User tab, selecting the Administrator user, and clicking Edit.

5. Enter the new password, verify it, and click OK.

10.2 Administrator Basics

The Administrator consists of tabs for configuring users, roles, projects, and
customizing both custom and default fields.

10.2.1 Users Tab

The Users tab is where you add, delete, and configure users and their roles in projects.
Roles determine the permissions the user has in each project. The users are displayed

at the top of the screen and the roles for the selected user are displayed on the bottom
of the screen.

This tab has the following options:
Add - displays the Add User dialog box for adding a new user.

Edit - displays the Edit User dialog box for the selected user. You can change the user's
name, username, or password.

Assign - Displays the Edit Role dialog box for assigning roles to the selected user for
the selected projects.
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Delete - deletes the selected user.

Username - displays the name the user will use to log on. Click the column header to
sort users in ascending order by this field.

First Name - displays the user's first name. Click the column header to sort users in
ascending order by this field.

Last Name - displays the user's last name. Click the column header to sort users in
ascending order by this field.

E-mail - displays the user's email address. When Enable E-mail notification is
selected for the user, the user will receive email notifications when items are created,
or when the owner or assigned to field is changed for issues. Click the column header
to sort users in ascending order by this field.

E-mail Notify - indicates whether the user will receive email notifications. Click the
column header to sort users in ascending order by this field.

Administrator Access - indicates whether the user can access the Oracle Test Manager
Administrator.

Active - this column is only displayed when named user licenses are being used.
Indicates whether the user is active, that is, allowed to log in using a named user
license.

Roles for <user> - displays the roles assigned to the selected user for each project in
the database.

= Project - displays a list of the projects in the database.
= Role - displays the role of the selected user for the project.

10.2.2 Roles Tab

The Roles tab is where you configure roles. Roles determine the read, write, delete,
and execute permissions for users in projects. Once roles are created, you assign them
to users for each project that you want them to have access to. A user's role can differ
from project to project. Click Assign on either the Projects tab or Users tab to assign
roles.

Add - displays the Add Role dialog box for adding a role.
Edit - displays the Edit Role dialog box for editing the selected role.

Delete - deletes the selected role. If a role is in use, you will be asked to assign another
role to users assigned to this role.

Permissions for <role> - displays the read, write, delete, and execute permissions for
this role for projects, requirements, tests, and issues.

s Project - displays the read, write, and delete permissions for projects for users
assigned to this role.

s Requirement- displays the read, write, and delete permissions for requirements
for users assigned to this role.

»  Test - displays the read, write, delete, and execute permissions for tests for users
assigned to this role.

» Issue - displays the read, write, and delete permissions for issues for users
assigned to this role.

s Public Reports - displays the read, write, and delete permissions for public reports
assigned to this role.
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= My Reports - displays the read, write, and delete permissions for reports assigned
to this role.

10.2.3 Projects Tab

The Projects tab is where you maintain projects.
Add- displays the Add Project dialog box for adding a new project.

Clone - displays the Clone Project dialog box for duplicating the selected project.
When you clone a project, user roles are the same as the original project.

Edit - displays the Edit Project dialog box for changing the name of the selected
project.

Assign - displays the Edit Role dialog box for assigning roles to users for the selected
project(s).

Delete - deletes the selected project.

Project - displays a list of projects in the database.
User - displays the users in the database.

First Name - displays the user's first name.

Last Name - displays the user's last name.

Role - displays the users' roles in the selected database.

10.2.4 Fields Tab

The Fields tab is where you customize both default and custom fields. These fields are
used in Oracle Test Manager for maintaining details about requirements, tests, issues,
and test runs.

This tab has the following options:

<Field List> - lists the categories and types of fields that you can customize. The
categories are:

= Requirements - fields that pertain to requirements that appear in the Add/Edit
Requirements dialog boxes and are displayed in the right pane.

»  Tests - fields that pertain to tests that appear in the Add/Edit Tests dialog boxes
and are displayed in the right pane.

= Issues - fields that pertain to issues that appear in the Add/Edit Issues dialog
boxes and are displayed in the right pane.

s Test Runs - fields that pertain to test runs that appear in the Run Test dialog box
and are displayed in the Result Parameters section of the right pane when you
click the run date of a test in the Run History section.

Each category has two types of fields:

s Default Fields - these are the fields that are shipped with the product. You can
add and delete options and change the labels.

s Custom Fields - these are user-created fields. These fields are used for entering
information in Oracle Test Manager. They are added to the input and edit dialog
boxes for requirements, tests, and issues. They are displayed in the right pane with
the default fields, and they can be used for grouping and reporting.

Name - displays the field name.
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Label - displays the label displayed in Oracle Test Manager.

Type - displays the type of field. The options are:

= Option List - lets you select an option from a list.

= Option List/Text - lets you select an option from a list or enter text.

s User List - creates a list of the users in the database and lets you select one.
s Text - lets you enter one line of text.

= Multiline Text - lets you enter multiple lines of text.

= Multiline/Append - creates a multiline text field and when editing, lets you
choose to append new text to existing text. If you choose to append, the date and
user name are automatically added.

= Heading - lets you create a heading for grouping custom fields. The heading is for
display purposes only in the right-hand pane of Oracle Test Manager.

Trigger Email Notification - indicates whether an email will be sent to the configured
recipients when this field changes.

Include In Email - indicates whether the field should be included in email.

Required - indicates whether the field is required, that is, data must be entered when
the requirement, test, or issue is created.

Enabled - indicates whether the field is being used in Oracle Test Manager.
Project - indicates the project to which this field applies.

Add - displays the Add Field dialog box for adding a custom field.

Edit - displays the Edit Field dialog box for the selected custom field.
Delete - deletes the selected custom field.

Move Up - moves the selected field up one place.

Move Down - moves the selected field down one place.

Option Lists - lets you maintain the options for the selected field if the field is an
option list type of field.

= Add - displays the Add Option dialog box for adding an option to the selected
field.

= Edit - displays the Edit Option dialog box for renaming the selected option.
s Delete - deletes the selected option.

= Move Up - moves the selected option up one place.

= Move Down - moves the selected option down one place.

»  Project - lets you select the project to which the options apply. This field is only
available when you select the Project Specific Options check box in the Add
Custom field dialog box for this field. When this check box is selected you can add
options specific to each project; otherwise, all projects will have the same options.

Email Recipients - lists the roles and/or email addresses of the people that will receive
an email when the selected field changes.

= Project - select the project for which you want to display the email recipients.

s Maillds - lists the email addresses to which email will be sent when the field
changes.

10-4 Oracle Test Manager - Test Manager User's Guide



Configuring Email Preferences

= Roles - lists the roles of the email recipients to which email will be sent when the
field changes.

When you select the category in the left pane, the associated fields are displayed in the
top right pane. When you select the field in the top right pane, its associated options
are displayed in the Option List.

10.3 Overview of the Menu Options

The menus provide options for saving changes to the database and for accessing the
database maintenance tools.

10.3.1 Tools Menu

The Tools menu lets you purge the database, unlock locked records, and set up the
e-mail configuration.

Unlock Locked Records - unlocks locked records in the database. This is an
emergency feature to be used to clear out locks in the database when the product fails
and leaves entries locked for editing.

Purge Deleted Records - physically removes all deleted data from the database.
Deleted items are marked as such and are not shown in the user interface; however,
they are kept in the database until the database is purged.

Setup E-mail Config - displays the Setup E-mail Configuration dialog box for
configuring the mail server to use for e-mail notifications.

Manage Default Reports - displays the Manage Default Reports dialog box for
selected which default reports will be visible to individual users.

10.3.2 Help Menu

Contents - opens the help system contents.

About Admin - provides version number and copyright information.

10.3.3 Logout

Exits the application.

10.4 Configuring Email Preferences

You can set up individual users so that they receive email notification when a new
requirement, test, or issue is created, or when the owner or assigned to field is changed
for an issue. In addition, you can configure emails to be sent to the owner and creator
when certain conditions occur. For this to work, the email server must be configured.

To configure the email server and email preferences:
1. Select Setup E-mail Config from the Tools menu.
2. Click Configure SMTP Settings.

This dialog box has the following options:

SMTP Server - enter the server name, and optionally a colon (:) followed by a port
number. The default port number is 25.

Return Address - enter the return address for email sent by Oracle Test Manager.
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10.5 Managing

You

Send To - enter the email address to which you want to send a test e mail when
you click the Test button.

Test - displays the Test E-mail Configuration dialog box for testing your
configuration.

Enter the SMTP Server name.

Enter the return address for emails sent by Oracle Test Manager.
Enter the email address to which you want to send the test email.
Click Test to test the configuration.

Click Traceability to select options for when to send email.

Notify creator of changes - sends an email to the node creator when the owner
changes. Email is not sent if the node creator becomes the current owner or if the
node creator initiated the activity.

Notify Owner of associated test(s) when a requirement changes - when a
requirement changes, sends an email to the owner of tests associated with this
requirement.

Notify Owner of associated issue(s) when a test runs - when a test runs, sends an
email to the owner of issues associated with this test.

Select when you want to send email.

Click Save.

Default Reports

can select the default reports that are available for each user on the Reports tab in

Oracle Test Manager. To manage default reports:

1.

Select Manage Default Reports from the Tools menu.

Users - lists the users. You can select more than one user using the Shift and Ctrl
keys.

Check all - selects all reports.
Uncheck all - deselects all reports.

Visible - when checked, the report will be available to the selected user(s). When
unchecked, the report will not be available to the selected user(s).

Reports - displays the report names.

Select the user(s) that you want configure reports for. Use the Shift and Ctrl keys to
select more than one user.

Select the reports that you want to be available to the user(s) on the Reports tab in
Oracle Test Manager.

Click Apply.
Click OK.

10.6 Working With Users

After you add a user you can then assign roles to the user for each project in the
database.
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10.6.1 Adding Users

To add users:
1. Click the Users tab.
2. Click Add. The Add User dialog box is displayed.
The Add user dialog box has the following options:
First Name - enter the user's first name.
Last Name - enter the user's last name.
E-mail - enter the user's email address for receiving email notifications.
Username - enter the username for logging on.
Password - enter the user's password.
Confirm Password - re-enter the user's password to confirm that it is correct.

Enable E-mail notification - select this option to enable email notification when
new issues are created and when the owner or assigned to fields are changed for
issues.

Enable Administrator Access - gives this user the ability to log on to the
Administrator for managing the database.

Enter the user's first name.
Enter the user's last name.
Enter the username that the user will use to log in.
Enter the user's password.

Confirm the user's password.

® N o g & @

Click OK. You can now edit the user's project permissions by selecting the project
and clicking Edit.

10.6.2 Deleting Users

To delete a user:

1. Click the Users tab.

2. Select the user you want to delete.
3. Click Delete.
4

Click Yes when asked to confirm.

10.6.3 Changing User Information

To change a user's name, login user name, password, or enable email notification:
1. Click the Users tab.

2. Select the user whose information you want to change and click Edit.

3. Make the necessary changes.

4. Click OK.
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10.6.4 Assigning Roles to Users

Roles determine the project permissions that each user has for a project. Project
permissions determine what users can do within the project. Read, write, and delete
permissions are assigned to the project, requirements, tests cases, and issues within
each project. Execute permission is also assigned to test cases. To assign roles to one
user for all projects:

1. Select the Projects tab.
2. Select the user for whom you want to assign roles.

3. Select the projects for which you want to assign roles for the selected user. Only
the selected projects will be displayed in the Edit Roles dialog box.

4. Click Assign.
Username - displays the user for whom you are assigning roles.
All - selects or deselects all of the listed projects.

Apply to all selected - applies the selected role to all of the selected projects. If
none is selected, the user will not have access to those project.

Checkbox - indicates if the project is selected.
Project - lists the projects that you previously selected on the User tab.

Role - select the role to assign to this user for the project. If none is selected, the
user will not have access to this project.

5. Select the role to assign to this user for each project.

6. Click OK.

10.7 Working With Roles

The Roles tab is where you configure roles. Roles determine the read, write, delete,
and execute permissions for users in projects. Once roles are created, you assign them
to users for each project that you want them to have access to. A user's role can differ
from project to project. Click Assign on either the Projects tab or Users tab to assign
roles.

10.7.1 Adding Roles

To add a role:
1. Click the Roles tab.
2. Click Add.

Name - enter a name for this role.
Description - enter a description for this role.

Base Role - when you select an existing role, the permissions for that role can be
used to start configuring the new role.

Select All - selects all permissions.
Select None - deselects all permissions.

The following permissions are available for the project, requirements, test cases,
issues, and reports:
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= Read - indicates whether users assigned to this role has read access to the
project, requirements, tests, issues, public reports, and private reports.

»  Write - indicates whether users assigned to this role can change the project,
requirements, tests, issues, public reports, and private reports.

s Delete - indicates whether users assigned to this role can delete the project,
requirements, tests, issues, public reports, and private reports.

= Execute - indicates whether users assigned to this role can execute tests.
Enter a name and description for this role.
Adjust the permissions for this role.

Click OK.

10.7.2 Editing Roles

To edit a role:

1.

2
3
4.
5

Click the Role tab.

Select the role you want to edit.
Click Edit.

Make any changes.

Click OK.

10.7.3 Deleting Roles

When you delete roles, Oracle Test Manager checks to see if the role is being used, that
is, if it is assigned to a user. If the role is in use, you will be prompted to assign another
role to the users assigned to the role. To delete roles:

1.

2
3.
4

Click the Roles tab.
Select the role that you want to delete.
Click Delete.

If the role is not in use, click Yes when asked to confirm the deletion. Otherwise
the Assign Role dialog box is displayed.

Username - displays the users that are assigned to this role.
Project Name - displays the project for which the users are assigned this role.

Please choose a role for re-assignment - select the role that you want to use
instead of the role you are deleting. The default is none.

Are you sure you want to delete the role <role> - click Yes to delete the role and
reassign the new roles to the user. Click No to exit without deleting the role.

Select the new role to assign to the users assigned to the role you are deleting.
Click Yes.

10.8 Working With Projects

You can add, clone, rename, assign roles to users for the project, and delete projects
from the database.
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10.8.1 Adding Projects
To add a project:

1. Select the Projects tab.
2. Click Add.

This dialog box has the following options:

New Project - enter the name of the new project.
3. Enter the project name.

4. Click OK.

10.8.2 Cloning Projects

Cloning a project lets you copy an existing project and then modify it so that you do
not have to do all of the configuration from scratch. Cloning a project copies the
project structure including the fields and assignments, but does not copy the project
data.

To clone a project:
1. Click the Projects tab.
2. Select the project that you want to clone.
3. Click Clone.
New Project- enter a name for the new project.
4. Enter the project name.

5. Click OK. You can click Assign to modify user roles for this project, if necessary.

10.8.3 Renaming Projects

To rename a project:

1. Select the Projects tab.

2. Select the project you want to edit.
3. Click Edit.

4. Enter the new name.

5. Click OK.

10.8.4 Deleting Projects

To delete a project:
1. Click the Projects tab.
2. Select the project you want to delete.

3. Click Yes when asked to confirm.

10.8.5 Assigning Roles to Project Users

Roles determine the project permissions that each user has for a project. Project
permissions determine what users can do within the project. Read, write, and delete
permissions are assigned to the project, requirements, tests cases, and issues within
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each project. Execute permission is also assigned to test cases. To assign roles to one
project for all users:

1. Click the Projects tab.
2. Select the project for which you want to assign roles.

3. Select the users for which you want to assign roles. Only the selected users will be
displayed in the Edit Role dialog box.

4. Click Assign.
Project - displays the project for which you are assigning roles.
All - selects or deselects all of the listed users.

Apply to all selected - applies the selected role to all of the selected users. If none
is selected, the user will not have access to those project.

Checkbox - indicates if the user is selected.
User - displays the users that you selected on the Projects tab.

Role - select the role to assign to this user for the project. If none is selected, the
user will not have access to this project.

5. Select the role to assign to each user for this project.

6. Click OK.

10.9 Working With Fields

Fields are used in Oracle Test Manager to describe issues, requirements, and tests.
There are two types of fields that apply separately to requirements, tests, issues, and
test runs:

Default fields - these are fields that come with the product such as Type, Priority, and
Status for requirements. You cannot add or delete default fields. You can change
whether they are required or enabled, and you can add, delete, or rename their
associated options.

Custom fields - these are fields that you add that are specific to your product. For each
custom field, you define its properties, then add options where appropriate.

10.9.1 Adding Options

Before adding custom fields, make sure to logout and close Oracle Test Manager.
When finished adding custom fields, logout and close the Administrator before
starting Oracle Test Manager.

To add an option to a default or custom field:
1. Click the Fields tab.

2. Select Default Fields or Custom Fields for the category of the field to which you
want to add an option.

3. Select the field to which you want to add an option.
4. Click Add to the right of the Option Lists section.

5. Enter the name of the new option.
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Select the Insert the new option at the top of list option if you want the new
option to appear at the top of the list. Clear the Insert the new option at the top of
list option if you want the new option to appear at the bottom of the list.

Click OK. Use the arrow buttons to reorder the list. The order in which they
appear in this list is the order in which they will appear in the drop down option
lists in Oracle Test Manager.

Note: The order of the priority field for requirements determines the
color of the icons displayed in Test Manager. For example, if High
priority is first in the list, the icon will be green. Following is a list of
colors and the corresponding display orders:

1 -Green
2-Orange
3-Red

4-Blue

5-Silver
6-Purple
7-Dark Orange
8-Light Blue
9-Gray

10.9.2 Renaming Options

To rename an option:

1.
2
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Click the Fields tab.

Select Default Fields or Custom Fields for the category of the field containing the
field with the option you want to change.

Select the field containing the option you want to change.
Select the option you want to rename.
Enter the new name.

Click OK. Use the arrow buttons to reorder the list. The order in which they
appear in this list is the order in which they will appear in the drop down option
lists in Oracle Test Manager.

10.9.3 Deleting Options

Note: If you delete a custom field option that has been used in a
requirement, test, or issue, Oracle Test Manager will default the
custom field to the first value in the option list the next time you edit
the requirement, test, or issue. For requirements, tests, or issues that
have not been edited and saved, the original value will remain
unchanged.

To delete an option:
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1. Click the Fields tab.

2. Select Default Fields or Custom Fields for the category of the field containing the
field with the option you want to delete.

Select the field containing the option you want to delete.
Select the option you want to delete.

Click Delete.
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Click Yes when asked to confirm the deletion.

10.9.4 Editing Default Fields

You can edit whether a default field is required, enabled, triggers an email when
changed, and whether it is included in the email. To edit a default field:

1. Click the Fields tab.
2. Select Default Fields in the left pane for the category of the field you want to edit.
3. Select the field you want to edit.
4. Click Edit to display the Edit Field dialog box.
This dialog box has the following options:
Name - displays the field name.
Label - displays the field label that is displayed in Oracle Test Manager.
Field Properties - select a property to enable it; deselect the property to disable it.

= Required - requires that the field be entered in Oracle Test Manager when
selected.

s Enabled - indicates whether the field is used in Oracle Test Manager.

s Trigger Email Notification - indicates whether an email should be sent to the
configured list of recipients when this field changes. Click the pencil icon to
display the Setup E-mail Configuration dialog box for configuring email
recipients.

s Include this field in notification mails - indicates whether the field should be
included in notification emails.

5. If you select Trigger Email Notification, the Setup E-mail Configuration dialog box
for this field is displayed.

Projects - select the projects for which you want to configure this field.

Checkbox - when checked, notification email will be sent to all users assigned tot
his role.

Roles - lists the roles.

E-mail - enter the email addresses of the people you want to receive notification
emails, separated by commas.

To - displays the Select Email recipients dialog box for selecting email recipients.
Set - saves the settings for the selected project.
6. Select the project for which you want to configure this field.

7. Select a role if you want all users assigned to the role to receive a notification
email.
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9.

10.
11.
12.

Enter the email addresses of recipients or click To to select from the list of users in
the database that have email notification enabled.

<recipient list> - lists users in your database that have email notification enabled.
Select - adds the selected recipients to the To field.

To - displays the selected recipients separated by a comma.

Select the recipients you want to add and click Select.

Click Done.

Click OK.

Make any other changes and click OK.

10.9.5 Adding Custom Fields

To add a custom field:

1.
2.

Click the Fields tab.

Select Custom Fields in the left pane for the category to which you want to add a
custom field.

Click Add to display the Add Custom Field dialog box.
This dialog box has the following options:
Name - enter the name of the field.

Label - enter the field label that will appear in the Oracle Test Manager dialog
boxes.

Type - select the type of field. The options are:

= Option List - lets you select an option from a list. You must add at least one
option before exiting the Administrator.

= Option List/Text - lets you select an option from a list or enter text.

»  User List - creates a list of the users in the database and lets you select one.
s Text - lets you enter one line of text.

= Multiline Text - lets you enter multiple lines of text.

= Multiline/Append - creates a multiline text field and when editing, lets you
choose to append new text to existing text. If you choose to append, the date
and user name are automatically added.

= Heading - lets you create a heading for grouping custom fields. The heading is
for display purposes only in the right-hand pane of Oracle Test Manager.

Applies To - select the project to which this field applies.
Properties - select the properties that apply to this field.
s Required - indicates whether the field must be entered.

s Enabled - indicates whether to make this field available to Oracle Test
Manager. Disabled fields are not available in Oracle Test Manager.

s  Trigger Email Notification - indicates whether an email should be sent to the
configured list of recipients when this field changes. Click the pencil icon to
display the Setup E-mail Configuration dialog box for configuring email
recipients.

10-14 Oracle Test Manager - Test Manager User's Guide



Working With Fields

10.
11.
12.

s Include this field in notification mails - indicates whether the field should be
included in notification emails.

»  Project Specific Options - when selected, you can add options specifically for
each project by selecting the project in the Option Lists section. If not selected,
all projects will have the same options.

If you select Trigger Email Notification, the Setup E-mail Configuration dialog box
for this field is displayed.

Projects - select the projects for which you want to configure this field.

Checkbox - when checked, notification email will be sent to all users assigned tot
his role.

Roles - lists the roles.

E-mail - enter the email addresses of the people you want to receive notification
emails, separated by commas.

To - displays the Select Email recipients dialog box for selecting email recipients.
Set - saves the settings for the selected project.
Select the project for which you want to configure this field.

Select a role if you want all users assigned to the role to receive a notification
email.

Enter the email addresses of recipients or click To to select from the list of users in
the database that have email notification enabled.

<recipient list> - lists users in your database that have email notification enabled.
Select - adds the selected recipients to the To field.

To - displays the selected recipients separated by a comma.

Select the recipients you want to add and click Select.

Click Done.

Click OK.

Enter other field information.

Click OK. For list type items, enter the options that will appear in the list. If you
have add an Option List, you must enter at least one option before exiting the
Administrator.

10.9.6 Editing Custom Fields

To edit a custom field:

1.
2.
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Click the Fields tab.

Select Custom Fields in the left pane for the category containing the field you
want to edit.

Select the field you want to edit.
Click Edit to display the Edit Field dialog box.
Make the necessary changes.

Click OK.
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10.9.7 Deleting Custom Fields

To delete a custom field:
1. Click the Fields tab.

2. Select Custom Fields in the left pane for the category containing the field you
want to delete.

3. Select the field you want to delete.
4. C(Click Delete.

5. Click Yes when asked to confirm the deletion.

10.10 Maintaining the Database

You can unlock locked records and purge deleted records.

10.10.1 Unlocking Locked Records

Use this procedure to clear out locks in the database when the product fails and leaves
entries locked for editing. To unlock locked records:

1. Select Unlock Locked Records from the Tools menu.

2. Click Yes to confirm.

10.10.2 Purging Deleted Records

Deleted items are not removed from the database until you purge the database. To
remove deleted items from the database:

1. Select Purge Deleted Records from the Tools menu.

2. Click Yes to confirm that you want to purge the database.

10.11 Data Links

The data link feature lets you configure and manage data links to third party systems
or other Oracle Test Manager systems. The data link allows you to import and export
requirements, issues, or manual tests so that the data is synchronized between both
systems.

Data nodes are synchronized using a custom field that serves as the third party node
identifier. The custom field must be created using Administrator for each type of node
you will be synchronizing, requirements, issues, and manual tests.

The synchronization is done via a folder system that is used to hold incoming and
outgoing nodes. You determine where the folder system resides when you create the
data link. If the folders are on your local machine and the third party tool is on another
machine, the folders must be shared.

The following folder structure is created:
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Figure 10-1 Visual Script Tree Hierachy

= 2 Default OTM
=1 |2 Emply Project

|2 eMEIssuell
|2) eMEIssuelnProcess
|2 eMEIssueQuk

IL2) eMEReqIM
|2) eMERequirementInProcess
|2) eMERequirementOut
|2) eMETestcaselnProcess
|2) eMETestcaseOut

|2 eMETestIM

The uppermost folder is the DSN name. The next folder is the project name. The
folders on the next level are the folders used for importing and exporting. The In
folders are where the third party tool must place nodes for importing into Oracle Test
Manager. The Out folders are where Oracle Test Manager places nodes for exporting to
the third party tool.

You can use either a CSV or XML file format for linking. If you use a CSV format, you
must map the fields in the third party tool to the fields in Oracle Test Manager. If you
are using an XML format, you must conform to the Oracle Test Manager DTD located
in the OracleATSN\OTM\Files\XML_DTD folder. Nodes that do not conform will not
be imported.

Imported nodes are moved to the BackUp folders. Nodes in these folders should
periodically be deleted.

Once a data link is created, you can start, stop, and delete them is using the Manage
Data Links option. When a data link is started, the Integrator dialog box is displayed
showing the data link properties and the Integrator progress. You can use this dialog
box to monitor status. When it is minimized it is placed in the system tray.

In addition to monitoring the Integrator progress, a log file is created showing
Integrator activity. This file is called <project name>_Integratorlog.logandis
located in the top-most folder.

10.11.1 Creating Data Links

Custom text fields for identifying third party nodes must be created before you create
the data link. The fields are:

_IntReqID for requirements
_IntTestID for manual tests
_IntIssuelD for issues

To create the custom fields:

1. Select the Fields tab.

Select Custom Fields under Requirements.
Click Add.

Enter _IntReqgID in the Name field.
Enter a label.

Select Text in the Type field.

Click OK.
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Repeat this process for manual tests and issues.
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To create a data link:
1. Select Run from the Start menu.
2. Change directories to <installdir>\0TMand run DBConfig.exe.
3. Select Create from the Datalinks menu.
4. Enter the username and password to access the Administrator.
5. Select the database for which you want to create a data link.
This dialog box has the following options:

Setup - These options let you configure the data link type and the frequency with
which it will check for new nodes.

= Select project to link - lists the projects that are available to link.

= Select other system to link - select the type of system to which you are
linking, third party tool or Oracle Test Manager.

= Select file format for link - select the type of format you are using to link. If
you select CSV you must Create the Mapping using the buttons below. If you
select XML you must conform to the Oracle Test Manager DTD.

= Run Integrator every - enter the frequency with which you want the
integrator to check for new items.

m  Abort after # of failures - enter the number of failures that must occur before
the Integrator stops running.

Nodes to Link - lets you configure the nodes to link.

= Select Data Link Location - displays the Select Data Link Location dialog box
for selecting where to create the Data Link folders.

= Requirements - select this check box if you want to link requirements.
= Manual Tests - select this check box if you want to link manual tests.
= Issues - select this check box if you want to link issues.
s Create Mapping - displays the Mapping tool for CSV files.

6. Enter the setup information.

7. Click Select Data Link Location to display the Select Data Link Location dialog
box.

Enter the location to create the Data Link folders.

8. If you are using CSV format select the node that you want to link and click Create
Mapping. If no CSV files exist in the associated in folder, an error is displayed.

This dialog box has the following options:

Selected Node Type - displays the node type that you are mapping, requirements,
issues, or manual tests.

CSV File Columns - lists the columns in your CSV file.

Fields available for mapping - lists the fields in Oracle Test Manager.
<right arrow> - maps the two selected fields.

<left arrow> - removes the mapping of the selected field.

Selected column contents - displays the contents of the selected column.
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Auto Match - automatically maps fields with the same name.

Select the CSV column name and the field that it maps to and click the right arrow.
Use Auto Match to map fields with the same name in both columns. The _
IntIssuelID, _IntTestID, and _IntIssuelD fields must be mapped to the
corresponding item number field in the third party tool.

Click OK.
Repeat this step for each node type that you want to link.

Click OK to save the data link. The data link is created but not running. Use
Manage Data Links to start the data link.

Two files are created one level up from the In folder. They are:

DL_<DSN name>_<project name>.xml - contains the mapping information
for this data link including status of the data link and the encoded administrator
password for security purposes. This file is located one folder level up from the In
folder.

<node type>Map.txt - contains the data link information. You can edit this file
to change data mapping. This file is located in the OracleATS/OTM/files folder.

10.11.2 Managing Data Links

When the data link is started, the Integrator looks in the IN folder and imports the files
it finds there. It also checks for updated Oracle Test Manager nodes and places them in
the Out folder for the third party tool to retrieve.

To start the data link:

1.

2
3.
4

Select Run from the Start menu.

Change directories to <installdir>\0TM and run DBConfig.exe.
Select Manage from the Datalinks menu.

Enter the username and password to access the Administrator.

This dialog box has the following options:

Link name - displays a list of data links that have a status of available.
Start - starts the data link.

Delete - removes the data link.

Data Link Properties - displays the data link's configuration information.
Select the data link that you want to start.

Click Start to display the Oracle Test Manager Integrator for viewing progress and
managing the data link.

This dialog box has the following options:

Data Link properties - displays the data link's configuration information.
Start - starts the data link.

Stop - stops the data link.

Progress - displays what the Integrator is doing.

When you minimize the Integrator it appears in the system tray. Once files are
imported they are moved to the BackUp folder.
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Note: Files are not automatically removed from the BackUp folder. It
is recommended that you periodically delete files from the BackUp
folder as it can get quite large.

A log file called <project name>_Integratorlog.log is created in the top most
folder. It contains a log of the Integrator activity that may be useful for
troubleshooting.

If you are using CSV format and the CSV file is missing a field that Oracle Test
Manager has, the Integrator creates it. If you are using XML format and the file does
not conform to the Oracle Test Manager DTD, it is not imported and a message is
placed in the log file.

10.11.2.1 Data Collisions

Following is a list of possible scenarios where a data collision might occur and how
Oracle Test Manager resolves them.

Scenario 1: Data about a node is received by Oracle Test Manager while the node is
being edited in Oracle Test Manager. This may occur when a node is being edited in
both systems. If the third-party system finishes first, it exports the file to Oracle Test
Manager's IN box.

Resolution: Before saving node data, Oracle Test Manager checks its IN box to see if
there is an update for the node. If there is an update, the node is not saved to the
database. The user will be asked what to do. The options are override the update or
accept the updated data.

When the user overrides the changes, the node is not imported, the changes made in
Oracle Test Manager is saved, and the node is then exported.

When the user accepts the changes, Oracle Test Manager discards its own data,
imports the node, and updates the data. The node is not exported.

Scenario 2: A node appears in both the IN and OUT boxes. This may occur when both
systems send update records to one another before they get imported. For example, if
a node is edited and saved in the third party system and the export is delayed for
some reason. In the mean time, Oracle Test Manager finishes updating and sends the
record. In this situation, there will be two versions of the same record waiting to be
imported by the systems.

Resolution: Before starting an import, the Integrator will look in its OUT box to see if
there is a record for the node it's about to import. If there is, the Integrator notifies the
user found in the file to be imported via email that a conflict has occurred and needs to
be resolved. No updates occur. The user must determine which file is correct and place
it in the IN box. If email notification fails, the event is logged to the log file.

Scenario 3: The connection between the two systems is broken. This occurs when the
machine with the shared folders is down.

Resolution: When Oracle Test Manager cannot write to the shared folder, the
administrative user is notified via email. It is up to the administrators of both systems
to resolve the problem. If email notification fails, the even is logged to the log file.

10.11.3 Deleting Data Links
To delete a data link:

1. Select Run from the Start menu.
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Change directories to <installdir>\0TM and run DBConfig.exe.
Select Manage from the Datalinks menu.

Enter the username and password to access the Administrator.

Select the data link that you want to delete.

Click Delete.

Click Yes when asked to confirm.

Administering the Database 10-21



Data Links

10-22 Oracle Test Manager - Test Manager User's Guide



11

Using the Windows Interface

This chapter explains how to use the Windows interface version of Oracle Test
Manager. The Windows interface version includes many of the same features as the
Web interface version.

11.1 Configuring Databases

You can add an existing database to Oracle Test Manager or you can create a new one.
In addition, you can create tables in an empty SQL database. When you add a
database, Oracle Test Manager creates a user account for the default user and the
administrator. Use Oracle Application Testing Suite Administrator to add more users
and to customize projects.

Select Oracle Application Testing Suite Database Configuration from the Oracle
Application Testing Suite - Tools menu to open the Configure Databases dialog box.

Refer to Chapter 9, "Configuring Databases" for instructions on adding, deleting, and
updating databases.

11.2 Logging In

To start the Windows version of Oracle Test Manager:

1. Select Oracle Test Manager - Windows from the Oracle Application Testing Suite
start menu to start Oracle Test Manager.

Enter your username.

Enter your password.

Select the database to which you want to log in.
Select the license type.

Click OK.
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11.3 Windows

The Oracle Test Manager Main window is where you perform Oracle Test Manager
activities. The main window consists of the menu options, toolbar, and once a project
is opened, the left pane and right pane. The left pane is a tree view that lists scripts,
requirements, or issues, depending on the tab that is selected. The right pane displays
the detailed information related to the item selected in the left pane.

The left pane has the following tabs:
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Requirements - lists the requirements that must be tested for this project. From here,
you can add, edit, or delete requirements. Once added, you can associate tests with
them so you know which tests address the requirement.

Tests - lists the test cases that pertain to this project. From here you can insert, edit, and
delete test cases. Once added, you can associate requirements and issues with them so
you know which requirements the test addresses and whether there are any issues
pertaining to the test. You can run individual tests, an entire branch, or all tests in the
project.

Issues - lists the issues created as a result of running the tests in the project. From here
you can insert, edit, and delete issues. Once added, you can associate tests and other
issues with them so you to know which test the issue effects and any related issues.
You can group issues in several ways using the right-click menu.

11.3.1 Custom Fields

In addition to the default information displayed in the right pane, there may be
optional custom fields. These fields are created by your system administrator.

11.3.2 Requirements Tab

The Requirements tab lets you work with requirements.

You can:

= Expand and collapse the tree view by clicking on the plus and minus signs.

= Move requirements by dragging and dropping them into their new locations.
= Search requirements by selecting Find from the Edit menu.

s Group requirements using the View menu or right-click menu.

»  Filter the requirement list using the View menu or right-click menu.

The color of the icon in front of the requirement indicates its priority. The color is
determined by the display order of the priority field as set up in Oracle Application
Testing Suite Administrator. The default colors are as follows:

= Red, high priority
= Yellow, medium priority
s Green, low priority

If you add additional priorities in Oracle Application Testing Suite Administrator, the
colors will be blue, silver, purple, dark orange, light blue, and gray.

The right pane lists the selected requirement’s details. In the upper right corner,
associated tests and issues are listed as well as attachments. You can:

s Click Edit this requirement to open the Edit Requirement dialog box.
s Click on an associated test or issue to view its details.
s Click on an attachment to open it in the appropriate application.

s Select Add/Edit to add or edit attachments or associated items.

11.3.3 Tests Tab

The Tests tab lets you work with tests.

You can:
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»  Expand and collapse the tree view using the plus and minus signs.
= Move tests by dragging and dropping them into their new locations.
= Search tests by selecting Find from the Edit menu.

= Group tests using the View menu or right-click menu.

= Filter the test list using the View menu or right-click menu.

The icon in front of the test indicates the type of test as follows:

= Functional test script - green with a scroll.

= Manual test - blue with a pencil.

»  Test folder - blue with a spiral.

= Functional Test group - blue with a plus sign.

s 3rd Party test - blue with two stars

The color of the icon in front of the test indicates the last result from running the test,
as follows:

= Green, passed

s Red, failed

= Yellow, warning

s Blue, not run

s Silver, currently running

The right pane lists the selected test's details. Test steps and run history are displayed.
You can:

s Click Edit this test to open the Edit Test dialog box.
s Click Run this test to execute the test.

s Click Delete Results to display the Delete Results dialog box for deleting results
from particular test runs.

s Click Download Test Script to save Visual Scripts that have been saved in the
database to your hard drive.

s Click the date in the Run History section to display result details for a particular
run.

In the upper right corner or the right pane, associated requirements and issues are
listed as well as attachments. You can:

s Click on an associated requirement or issue to view its details.
s Click on an attachment to open it in the appropriate application.

s Select Add/Edit to add or edit attachments or associated items.

11.3.4 Issues Tab

The Issues tab lets you work with issues.
You can:
s Group issues using the View menu or right-click menu.

= Filter the issue list using the View menu or right-click menu.
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= Search issues by selecting Find from the Edit men u.

The color of the icon in front of the issue indicates its priority. The default colors are as
follows and can be changed by changing the order of the Issue Priorities in Oracle
Application Testing Suite Administrator:

= Red, high priority

= Yellow, medium priority

s Green, low priority

The number inside the icon corresponds to the status number.

The right pane lists information about the selected issue including the issue's details,
solution, priority, and status. You can:

s Click Edit this issue to open the Edit Issue dialog box.

In the upper right corner of the right pane, associated requirements, tests, and issues
are listed as well as attachments. You can:

»  Click on an associated test, requirement, or issue to view its details.
s Click on an attachment to open it in the appropriate application.

s Select Add/Edit to add or edit attachments or associated items.

11.4 Toolbar

The Toolbar has the following buttons:

Open- displays the Select Project dialog box.

Cut - copies the selected component to the clipboard and deletes it when it is pasted.
Copy - copies the selected component to the clipboard.

Paste - pastes the contents of the clipboard into the left pane at the current location.
Find - displays the Find dialog box for searching requirements, tests, and issues.
History - displays the History dialog box for viewing the selected item's history.
Add Requirement - displays the Add Requirement dialog box.

Add Test - displays the Add New Test dialog box.

Add Issue - displays the Add Issue dialog box.

Delete - deletes the selected item.

Edit - displays the Edit Requirement, Edit Test, or Edit Issue dialog box, based on the
selected item.

Move Up - moves the selected item up one spot at its current level.
Move Down - moves the selected item down one spot at its current level.
Outdent - moves the selected item to the same level as its parent.

Indent - moves the selected item to a sub menu of the previous item.
Run - runs the selected test.

Abort Test - stops the running test.

View Schedule - displays the Schedule dialog box.

Activate Schedule - starts the schedule.
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Deactivate Schedule - stops the schedule.
Help - displays the help system contents.

Select Toolbar from the View menu to show or hide the toolbar.

11.5 Overview of the Menu Options

The menus provide options for accessing the various Oracle Test Manager features.
Many of these menu options have corresponding links in the right detail pane.

11.5.1 Project Menu
The Project menu options let you work with Oracle Test Manager projects.

Open - displays the Select Project dialog box for opening an existing project. More
than one project can be open at one time.

Close - closes the project.
Properties - displays the name of the project and the database in which it is located.

Exit- closes Oracle Test Manager.

11.5.2 Edit Menu

The Edit menu options let you add, edit, and delete components as well as and
associate them with one another. The options on this menu vary depending on which
tab is selected in the left pane.

Cut - deletes the selected component and places it on the clipboard.
Copy - copies the selected component to the clipboard.
Paste - pastes the contents of the clipboard into the left pane.

Find - displays the Find dialog box for searching requirements, tests, and issues.

11.5.3 View Menu

The View menu lets you show or hide the toolbar and status bar, refresh the display;,
group issues, and view test history and reports.

Toolbar - when checked, the toolbar is displayed.

Status Bar - when checked, the status bar is displayed.

Refresh - refreshes the display and reloads the tree from the database.

Filter - lets you select which items to display in the left pane based on field values.
= No filter - shows all items.

»  Customize Filters - shows only the requested items.

Group by - lets you select how to sort items in the left pane. It has the following
options.

= No Grouping - lists items sequentially.

= Group by <field> -sorts items into folders by the indicated field. The options
available differ for requirements, tests, and issues.
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s Customize Groupings - displays the Customize Groupings dialog box for
multi-level sorting. For example, you could sort by assigned to and then priority
within assigned to.

Requirement/Test/Issue History - displays the History dialog box for viewing
changes, by date, that have been made to the selected item.

Schedule - displays the Schedule dialog box for creating or editing the schedule.
Activate Schedule - starts the schedule.
Deactivate Schedule - stops the schedule.

Display Unique IDs - displays unique IDs for requirements and tests.

11.5.4 Actions Menu

The Actions menu lets you add, edit, and move requirements, tests, and issues. It also
lets you attach files, associate items, and run tests.

Add - displays the options for adding requirements, tests, or issues based on the
selected tab.

= Add Requirement/Test/Issue - displays the Add Requirement, Add Test, or Add
Issue dialog box for adding a new component. The component is added after the
selected component at the same level.

s Insert Requirement/Test- displays the Insert Requirement or Insert Test dialog
box for inserting a component directly above the selected component. This option
is not available for issues.

= Add Sub Requirement/Sub Test - displays the Add Child Requirement or Add
Child Test dialog box for adding a component at the level below the selected
component. This option is not available for issues.

Edit Requirement/Test/Issue - displays the Edit Requirement, Edit Test, or Edit Issue
dialog box for editing the selected component.

Delete Requirement/Test/Issue - deletes the selected component and its sub
components.

Move - displays the following options for moving the selected item in the tree view.
= Move Up - moves the selected item up one spot at its current level.

= Move Down - moves the selected item down one spot at its current level.

s Outdent - moves the selected item to the same level as its parent.

s Indent - moves the selected item to a submenu of the previous item.

Associate - displays the options for associating requirements, tests, and issues based
on the selected tab.

Attach File - displays the Attach File dialog box.

Run Test - displays the following options for running tests. These options are only
available when the Test tab is selected.

s Run Test - executes the selected test.
s Run Test Branch - executes all tests in the selected branch.
= Run All Tests - executes all tests in the project.

= Abort Test - stops the running test.
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Edit Test Steps - displays the Test Steps dialog box for editing test steps. This option is
only available when the Test tab is selected.

Delete Test Results - displays the Delete Results dialog box for selecting the results to
delete. This option is only available when the Test tab is selected.

Schedule Test- displays the Schedule Test dialog box for adding the selected test to the
schedule.

11.5.5 Tools Menu

The Tools menu lets you start Oracle Functional Testing or Oracle Load Testing.
Oracle Functional Testing - starts Oracle Functional Testing.
Options - displays the Options dialog box for setting Oracle Test Manager options.

User Properties - displays the User Properties dialog box for changing your password,
name, or email address.

Configure Databases - displays the Configure Databases dialog box for adding,
removing, and updating databases.

Import - lets you import data from an external XML or CSV file.

Export - lets you export data to an XML file. It has the following options.
s Export Requirement/Test/Issue - exports the selected item.

= Export Requirement/Test/Issue Branch - exports the selected branch.
= Export All Requirements/Tests/Issues - exports all items.

s Export Project - exports the project to an XML file.

11.5.6 Help Menu

Contents - opens the help system contents.

About Oracle Test Manager - provides version number and copyright information.

11.6 Setting Options

You can set options that determine:
= how Oracle Test Manager runs Oracle Functional Testing when running tests,
= whether Oracle Test Manager automatically creates issues for failed tests,
= the number of test results to display.
To set options:
1. Select Options from the Tools menu.
This dialog box has the following options:

Run Oracle Functional Testing hidden - runs Oracle Functional Testing in hidden
mode when running tests.

Close Oracle Functional Testing between test runs - closes Oracle Functional
Testing after each test run, then reopens it to run the next test.

Automatically create issues for failed tests - Oracle Test Manager automatically
creates issues for tests that fail.
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Copy results with tests - copies both the test and its results.

Limit number of displayed test results - when selected, you can enter the
maximum number of test results you want to show, otherwise all test results are
shown.

2. Select the options you want to enable.

3. Click OK.

11.7 Changing User Properties

You can change your user name, email address, password, and enable or disable email
notification for each database to which you have access. To change your user
information:

1. Select User Properties from the Tools menu.
This dialog box has the following options:

Database - select the database for which you want to change your user
information.

First Name - displays your first name.
Last Name - displays your last name.

E-mail - displays the e-mail address to which e-mail notification will be sent if the
Enable E-mail notification option is selected.

Enable E-mail notification - enables and disables e-mail notification. Notification
is sent when a new requirement, test, or issue is created and when an issue's
owner or assigned to field is changed.

Password - lets you change your password.

s Old - enter the current password.

= New - enter the new password.

= Confirm - enter the new password again.
2. Select the database for which you want to change your information.
3. Make any changes.
4. Click OK.

11.8 Grouping ltems

You can change the order in which requirements, tests, and issues are displayed by
changing the way they are grouped. The default view is not grouped. Items are listed
in order. Oracle Test Manager provides some standard grouping selections or you can
customize the grouping according to the information that is most important to you.

11.8.1 Using the Standard Grouping Selections
To group items:

1. Select the tab corresponding to the category you want to group, requirements,
tests, or issues.

2. Select Group by from the View menu.
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3.

Select the way you want to sort the items. Items are redisplayed grouped into
folders and subfolders.

Click the folder level to display a list of items in the folder. Click the item for which
you want to view details.

11.8.2 Using Customized Grouping

To customize groups:

1.

4.

Select the tab corresponding to the category you want to group, requirements,
tests, or issues.

Select Group by from the View menu then select Customize Groupings. You can
group items up to four levels.

Select how you want to group issues. You can group by both default and custom
fields.

Click OK. Items are redisplayed grouped into folders and subfolders.

Click the folder level to display a list of items in the folder. Click the item for which
you want to view details.

11.9 Filtering ltems

You can filter requirements, tests, and issues to display only those items in which you
are interested. You can filter by both default and custom fields. Requirements and tests
must be grouped before they can be filtered. Issues can be filtered whether or not they
are grouped.

To filter items:

1.

Select the tab corresponding to the items you want to filter, Requirements, Tests,
or Issues.

If you are filtering requirements or tests, group them first as described above.

Select Filter from the View menu then select Customize Filters to display the
Filter dialog box.

This dialog box has the following options:
Field - select the field that you want to use to select the items to display.

Value - enter or select the value of the field that you want to use to select the items
to display.

Equals - causes only items that match the value for the selected field to be
displayed.

Not Equal - causes only items that do not match the value for the selected field to
be displayed.

Select the field by which you want to filter.
Select or enter the value by which you want to filter.

Select Equals if you want to display items that match the value. Select Not Equal
if you want to display items that do not match the value.

Repeat these steps to filter to three levels, if required.

Click OK. The left pane is redisplayed according to your selections.
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Note: Items that are not displayed are still in the database. To display
the default view select Filter from the View menu then select No
Filters.

11.10 Working with Projects

The following sections explain the project options.

11.10.1 Opening Projects
To open a project:
1. Select Open from the Project menu.

2. Select the database that contains the project you want to open. The projects
displayed are only those in the selected database.

3. Select the project you want to open.

4. Click OK.

11.10.2 Copying Between Projects

You can copy requirements and tests from one project to another.
1. Open both projects by selecting Open from the Project menu.
2. Select Tile from the Window menu so that both projects can be viewed.

3. Make sure the same tab is selected in both projects. For example, if you are
copying requirements, select the Requirements tab in both windows. If you do not
do this, nothing will be copied.

4. Select the item you want to copy and select Copy from the Edit menu.

5. Select the destination project and select Paste from the Edit menu. Note that
associations are not copied.

11.10.3 Viewing Project Properties

You can view the project name and its location. To view project properties, select
Properties from the Project menu.

This dialog box has the following options:
Name - displays the project name.
Database - displays the name of the database in which the project is located.

Version - displays the database version.

11.11 Using Attachments

You can attach files containing additional or related information to requirements, tests,
or issues. The attachment will open in a separate window in the appropriate program.

11.11.1 Attaching Files to Requirements, Tests, or Issues
To attach a file:

1. Select the Requirement, Test, or Issue to which you want to add an attachment.
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2.

N

Select Attach File from the Actions menu.
This dialog box has the following options:
File - displays the full path and name of the attachment.

Location - displays Database if the attachment was stored in the database;
otherwise displays the path.

Close - closes the dialog box.
Add - displays the Open dialog box.

Remove - either removes the reference to the attachment or deletes the attachment
from the database. Attachments are not deleted from the local machine.

Copy to DB/Update DB - for attachments stored in the database, updates the
selected attachment, otherwise stores the attachment in the database.

Save Local - for attachments stored in the database, displays the Save As dialog
box for saving the attachment to the local machine.

Click Add to display the Open dialog box.
Navigate to the file you want to attach and select it.

Select Store in Database to save the attachment in the database. This allows the
attachment to be opened on other machines.

Click Open.
Click Close.

11.11.2 Opening Attachments

Attachments are opened in a separate window in their associated application. You can
open attachments that are stored in the database or located on the machine you are
using. You can also edit attachments stored in the database. If you do, Oracle Test
Manager asks you if you want to save the changes to the database when you close the
window.

To open an attachment:

1.
2.

Select the Requirement, Test, or Issue containing the attachment.

Click the attachment that you want to open in the Attachment section of the right
pane.

11.12 Viewing History

You can view, by date, the history of changes for an individual requirement, test, or
issue.

To view history:

1.
2

Select the requirement, test, or issue that you want to view.

Select Requirement, Test, or Issue History from the View menu.

This dialog box has the following options:

Date - lists the dates on which changes were made to the selected item.
<Detail> - displays the details of the selected item as of the selected date.

Select the date you want to view.
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4. Click OK when you are done.

11.13 Searching Projects

You can search requirements, tests, and issues based on the value of individual fields.
To search:

1.

Select Find from the Edit menu.
This dialog box has the following options:

Project - lets you select whether to search the current project only or all projects in
the current database.

»  Current Project - searches only the current project.

s Current Database - searches all projects in the current database.
Component - specifies the component to search:

= Requirements - searches through requirements.

»  Tests - searches through tests.

» Issues - searches through issues.

Criteria - specifies the search criteria:

»  Field - select the field to search through. The fields listed are determined by
the selected component.

m  Value - select or enter the value to search for. The values listed are determined
by the selected field. Not all fields let you enter a value.

= Equals - returns only exact matches.
s Contains - returns matches if the field contains the value.

Results - lists the matches. Double-click on an item to display it in Oracle Test
Manager.

Select whether to search only the current project or all projects in the database.
Select the component through which you want to search.

Select the search criteria.

Note: You can use SQL characters for searching. For example, if you
wanted to find all issues that contained Joe Smith and Mary Jones in
the description field, you could enter %]Joe Smith%Mary Jones% in the
value field.

Click Search. Double-click on an item in the Results list to display it in Oracle Test
Manager.

11.14 Importing and Exporting Data

You can import and export data to and from Oracle Test Manager. Data is exported as
an .XML file. Data can be imported from either an . XML file or a Comma Separated
Value (.CSV) file. This is useful for example, if you have created your test cases using a
third party tool.
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11.14.1 Importing an XML File

If you are importing an .xml file that was previously exported from Oracle Test
Manager, you will need any .bin files that were also created during the export. Data
being imported is put in the current project. Only one project can be imported from
any one .xml file. If an .xml file has more than one project, import it using Oracle
Application Testing Suite Administrator.

To import an .xml file:

1. Select Import from the Tools menu to display the Open dialog box.
2. Select the file type .xml.

3. Select the file you want to import.

4. Click Open to display the Import dialog box.

This dialog box lists the requirements, tests, and issues that will be imported. It
lets you review the data before importing it.

5. Click OK to import the data.

11.14.2 Importing a CSV File

To import data from a .csv file, Oracle Test Manager must match the columns in the
.csv file with the fields in the database. It assumes that the first row in the .csv file
contains labels indicating the type of data in the columns. Oracle Test Manager lets
you either manually map the columns to the database fields or lets you choose to let
Oracle Test Manager automatically map the columns to the database fields.

To import a .csv file:
1. Select Import from the Tools menu to display the Open dialog box.
2. Select the file type .csv.
3. Select the file you want to import.
4. Click Open to display the Import CSV File dialog box.
This dialog box has the following options:

Type - indicates the type of data you are importing. Select Issues, Requirements, or
Tests. The list of fields changes based on your selection.

# - lists the column number in the .csv file.
CSV Column - displays the column label in the .csv file found in the header row.

Field - lists the Oracle Test Manager database fields for the type of data you are
importing, Requirements, Tests, or Issues.

CSV Column - displays the column label in the .csv file that matches the Oracle
Test Manager database field. This column is blank until you either click Auto
Match or manually associate the labels.

Row - when a column is selected, displays the data in the column. This is useful
when you want to verify the data in the .csv file.

<Up arrow> - scrolls up the rows in the .csv file displaying the data for the
selected column.

<Down arrow> - scrolls down the rows in the .csv file displaying the data for the
selected column.

Using the Windows Interface  11-13



Importing and Exporting Data

<Left arrow> - when a field is selected, removes the association between the .csv
file label and the Oracle Test Manager database field.

<Right arrow> - when both a field and a column label are selected, moves the
selected column label into the column field on the left, indicating that the data in
this column corresponds to the expected data for the database field.

Auto Match - Oracle Test Manager tries to match the .csv file column labels with
the database fields. If it finds matches, they are listed to the right of the Field
column.

Select the type of data you are importing. Only one type of data can be imported
from any one .csv file because the column labels and data are different for
requirements, tests, and issues.

Match the column labels with the database field names. You can do this in two
ways:

= automatically by clicking Auto Match.

= manually by selecting a field and a column label and clicking the left arrow. To
view the data in the .csv file, select the column label and use the up and down
arrow keys.

Click OK when you are finished matching columns.

This dialog box lists the requirements, tests, and issues that will be imported. It
lets you review the data before importing it.

Click OK.

11.14.3 Exporting Data

You can export an entire project, an individual requirement, test, or issue, a branch of
requirements, tests, or issues, or all requirements, tests, or issues to an .xml file. In
addition to the .xml file, several .bin files are created that contain associated data such
as attachment files. If you are copying or emailing the exported data to another
location for later import, you will need the .xml file and all of the associated .bin files.
To export data:

1.

Select the data you want to export:
= Select Export Project from the Tools menu to export the entire project.

= Select the tab of the type of data you want to export, select an individual item
or branch if you are exporting a subset of an item, then select Export from the
Tools menu and whether you want to export the selected item, the selected
branch, or all items in this category.

If you are exporting the entire project, you will be asked if you want to export
attachments.

If you have selected an item that has associated items, you are asked if you want to
export them as well. Click Yes to export associated items.

The Save As dialog box is displayed. Enter a file name and select a location to save
the file.

Click Save.
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11.15 Working With Requirements

Requirements reflect the test plan for the project. Similar requirements can be grouped
together into branches for easy management. Once entered, they can be associated
with the tests that address them. Requirements are automatically numbered when you
add them. You can reorder them using the move buttons.

11.15.1 Adding Requirements

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

Requirements are automatically numbered when you add them. You can reorder them
by dragging them to the new location. To add a requirement:

1.
2.

Select the Requirements tab.
Select Add from the Actions menu then select one of the following options:

= Add Requirement - to add a requirement after the selected requirement at the
same level.

= Insert Requirement - to add the requirement above the selected requirement
at the same level.

= Add Sub Requirement - to add a requirement one level below the selected
requirement.

The Add Requirement dialog box is displayed. This dialog box has the following
options:

Name - enter the name of the requirement.

Type - enter the type of requirement. These options can be changed by your
system administrator.

Owner - select the user that owns the requirement. These options can be changed
by your system administrator.

Status - select the status of the requirement. These options can be changed by your
system administrator.

Priority - select the priority of the requirement. These options can be changed by
your system administrator.

Description - enter additional details about the requirement.

Attachment - lets you add an attachment to this requirement. Click Browse to
display the Open dialog box for selecting the file to attach.

Enter the requirement details.

Click OK.

11.15.2 Deleting Requirements

To delete requirements:

1.
2.

Select the requirement or branch that you want to delete.

Select Delete Requirement from the Actions menu.
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3.

Click Yes when asked to confirm the deletion. The requirement and all its sub
requirements are deleted from the database.

11.15.3 Editing Requirements

To edit a requirement:

1.

2
3.
4

Select the requirement you want to edit.

Select Edit Requirement from the Actions menu.
Make any changes.

Click OK.

11.16 Associating Tests With Requirements

To associate tests with a requirement:

1.
2.

Select the requirement with which you want to associate a test.
Select Associate from the Actions menu then select Associate Test.

This dialog box lists all of the tests in the project in an expanded tree view.

nn

Associated tests have an "x" in the checkbox in front of them. It has the following
options:

<test list> - click tests to add and delete them from the list of associated tests.
OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Select All - selects all tests.

Clear All - deselects all tests.

Next - moves to the next associated test.

Previous - moves to the previous associated test.

Select the tests you want associated with this requirement. The number of selected
items is displayed at the bottom of the window.

Click OK. The tests will be listed in the right pane under associated tests.

11.17 Working With Tests

Tests can be manual or automatic. Automatic Oracle Functional Testing scripts can be
run from Oracle Test Manager. For manual tests, you enter the individual test steps.
When you run a manual test, a wizard guides you through each step, allowing you to
enter the results.

Tests can be grouped together into branches for easy management. Once entered, they
can be associated with the requirements they address or any issues that result from
running the test.

Scripts are saved in the database so that the tests can be run from other machines.
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11.17.1 Adding Tests

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

Tests are automatically numbered when you enter them. You can reorder them by
dragging them to the new location. To add a test:

1.
2.

Select the Tests tab.

Select Add from the Actions menu, then select one of the following options:

= Add Test - to add a test after the selected test at the same level.

» Insert Test - to add the test above the selected test at the same level.

= Add Sub Test - to add a test one level below the selected test.

This dialog box has the following options:

Name - displays the test name.

Type - displays the type of test. The last type selected is displayed first in the last.

s Oracle Functional Test Script - Visual Scripts created using Oracle Functional
Testing.

= Manual Test - manual tests are entered, performed, and kept track of
manually.

»  Test folder - high level descriptions for grouping tests together.

s Test Group - a list of Oracle Functional Testing tests that are sequentially run
together that can also be scheduled. In addition, the overall results are tracked
and displayed.

Owner - displays the user that owns the test.

Functionality - displays the description of the functionality the test is designed to
verify.

Priority - displays the priority of the test. These options can be changed by your
system administrator.

Description - displays the test description.

Attachment - lets you add an attachment to this test. Click Browse to display the
Open dialog box for selecting the file to attach.

Workspace - for Oracle Functional Testing tests, displays the Workspace where the
test is located.

Test File - for Oracle Functional Testing tests, displays the Visual Script test file
name.

Store in Database - when selected, the test is stored in the database which allows
it to be run from another machine.

Use All Rows of Databank - when selected, the test will use all values in the
databank. When not selected, the test runs once using the first row if there is a
databank.

Enter the name of the test. If you are adding more than one test script at the same
time, you do not need to enter a name.
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11.

12.

Select the type of test. To create a top level header that does not have a script
associated with it, use the Description type.

Select the owner of the test.

Select the test priority.

Select the workspace in which the script is located.

Enter the file name or click Browse to locate the file or files.

Select the files you want to add and click Open.

. Select Store in Database if you want to run the test from a machine other than the

machine where the test resides.

Select Use All Rows of Databank if you want to iterate through the databank.
Otherwise, the test runs once using the first row of the databank, if there is one.

Click Ok.

Note: If you are adding a manual test, select Edit Test Steps from the
Actions menu to add details about the test. If you are adding an
Oracle Functional Testing Group, click Add/Edit in the right pane in
the Test List area to add Oracle Functional Testing tests to the group.

11.17.2 Adding Multiple Tests

To add multiple tests:

1.

@ o » w N

N

Click the Tests tab.

Select Add from the Actions menu then select Add Test.
Click Browse.

Select the tests you want to add.

Click Open. The tests are displayed in the Test File field.

Click OK. Each script is added as a separate test using the file name as its label in
the tree.

Use the arrow keys to move the tests to their desired locations.
To change test names, select the test, then select Edit Test from the Actions menu.

Click OK.

11.17.3 Adding Functional Tests to a Test Group

Once you have created a Test Group, you can add tests to it. The tests in the group are
run sequentially, and the group can also be scheduled. To add tests:

1.
2.
3.

Click the Tests tab.
Select the Oracle Functional Testing Group to which you want to add tests.

In the right pane, click Add/Edit in the Test List area to display the Tests dialog
box.

This dialog box has the following options:

All Tests - displays the project's tree view for selecting the tests that you want to
add to the group.
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<right and left arrows> - let you add and remove tests from the group.

Tests in Group - displays the tests that are in the group. To remove a test, select it
and click the left arrow.

Select the Oracle Functional Testing tests that you want to add.
Click the right arrow to move them into the group.

Click OK.

11.17.4 Editing Test Steps

For manual tests, you can add, delete, or edit the test steps.

For Oracle Functional Testing tests, you can edit test steps for the purposes of
describing the test in Oracle Test Manager. Changing these steps has no effect on how
the script is executed.

To edit test steps:

1.
2.

3.
4.
5.

Select the manual test you want to edit.
Select Edit Test Steps from the Actions menu.

This dialog box lets you edit and keep track of test steps for manual tests. It also
lets you add comments to Oracle Functional Testing scripts for the purpose of
documentation in Oracle Test Manager only.

This dialog box has the following options for Oracle Functional Testing scripts:
Step - displays the step number.

Page - displays the page being tested by the step.

Comment - displays additional information about the step.

This dialog box has the following options for manual tests:

Step - displays the step number.

Action - displays the action to perform.

Expected Result - displays a description of what is expected to happen as a result
of this step.

Comment - displays additional information about the step.

Delete - deletes the selected step.

Move Up - moves the selected step up one position in the list.
Move Down - moves the selected step down one position in the list.
This dialog box has the following options for all tests:

OK - exits the dialog box and accepts changes.

Cancel - exits the dialog box without accepting changes.

Select the step you want to edit or click New to add a step.

Repeat for all steps you want to edit or add.

Click OK.
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11.17.5 Restarting Functional Tests During a Test Run

When looping scripts or running a series of scripts in succession over an extended
time period, Oracle Functional Testing and it's embedded IE browser may consume

increasing amounts of memory. To manage memory, you can create a blank script that

will stop and then start Oracle Functional Testing. This script can be used as many
times as necessary, allowing you to define where the restart occurs. This lets you
maintain the session state between consecutive scripts where you may not want to

restart to occur.

To use the restart feature:

1.
2.
3.

Select Options from the Tools menu.
Make sure that Close Oracle Functional Testing between test runs is deselected.

In Oracle Functional Testing, create a blank Oracle Functional Testing script with
the following name: RESTART_ETESTER.mom. Case is important.

In Oracle Test Manager, insert this script as a node anywhere in your Tests tree
where you want an Oracle Functional Testing restart to occur.

11.17.6 Deleting Tests

To delete a test from the project:

1.
2.
3.

Select the test you want to delete. If the test has sub tests these are also deleted.
Select Delete Test from the Actions menu.

Click Yes when asked to confirm the deletion.

11.17.7 Editing Tests

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

To edit tests:

1.
2.

Select the test you want to change.

Select Edit Test from the Actions menu.

This dialog box has the following options:

Name - displays the test name.

Type - displays the type of test. This field cannot be changed.
Owner - displays the owner of the test.

Functionality - displays the description of the functionality the test is designed to
verify.

Priority - displays the test's priority. These options can be changed by your system
administrator.

Description - displays the test description.

Attachment - lets you add an attachment to this test. Click Browse to display the
Open dialog box for selecting the file to attach.

11-20 Oracle Test Manager - Test Manager User's Guide



Running Tests

Workspace - for Oracle Functional Testing tests, displays the Workspace where the
test is located.

Test File - for Oracle Functional Testing tests, displays the Visual Script test file
name.

Store in Database/Update Database - the test is either stored in the database or if
it is already in the database, updated in the database, allowing it to be run from
another machine.

Use All Rows of Databank - when selected, the test will use all values in the
databank. When not selected, the test runs once using the first row if there is a
databank.

Replace Test Steps - the test steps are deleted and reset to what is in the Oracle
Functional Testing script.

3. Make any necessary changes.

4. Click OK.

11.18 Running Tests

You can run all of the tests in the project, all tests in a branch of the project, or
individual tests. Manual tests are not run when you run all tests or a test branch. They
can only be run individually or as part of en Oracle Functional Testing Group. When
you run a manual test, the Manual Test wizard runs to guide you through the steps
and to allow you enter results.

You can set up Oracle Test Manager to automatically create an issue and associates it
with the test if the test fails. Refer to Setting Oracle Test Manager Options in Chapter 2.

Note: You cannot run tests that are not stored in the database and are
located on a different machine.

11.18.1 Running an Automated Test

To run automated tests:
1. Select one of the following:

s Torun an individual test, select the test and select Run Test from the Actions
menu then select Run Test.

= Torun all tests in a branch, select the top level of the branch, and select Run
Test from the Actions menu then select Run Test Branch.

s To run all tests in the project, select Run Test from the Actions menu then
select Run All Tests.

The Run All Tests dialog box has the following default options. It may have
additional fields if your administrator has added custom fields.

Version - enter the version of the software you are testing. This lets you to match
test results with the version of the software that was tested.

2. Enter the version number of the software you are testing.
3. Enter custom field information, if any.

4. Click OK.
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11.18.2 Running a Manual Test

To run a manual test:

1.
2.

Select the test you want to run.

Select Run Test from the Actions menu then select Run Test to start the manual
test wizard.

The Run Test dialog box has the following options. It may have additional fields if
your administrator has added custom fields.

Build Version - enter the version of the software you are testing.

Enter the version number of the software you are testing and custom fields, if any,
and click Next.

The step dialog box appears for each step in the test. It has the following options:
Action - displays the action to perform.

Expected Result - displays the expected result.

Comment - displays additional information about the step.

Result - select the outcome of the step after performing it.

Summary - enter additional information about the step.

Create an issue - automatically adds an issue stating that the test had a status of
failed or warning. This option is only available when Failed or Warning is selected.

The Run Manual Test - Step dialog box is displayed for each step in the test. When
you have completed the step, select the result and enter a comment.

Click Next to go to the next step.

The summary dialog box appears after all of the steps in the test have been
completed. It has the following options:

Result - enter the overall outcome of the test.
Summary - enter additional information about the test.

After the last step, the Run Manual Test - Summary dialog box is displayed. Enter
the overall test result and any summary comments and click Finish.

11.18.3 Running a Test Group

When you run a Test Group, Oracle Test Manager runs the tests in the group in
sequence. If there are any manual tests in the group you will be informed that human
intervention may be required and asked if you want to continue. If you choose to
continue, the Run Manual Test wizard prompts you through any manual tests in the

group.
To run a test group:

1.

Select the test group and select Run Test from the Actions menu then select Run
Test.

Enter the version number of the software you are testing and any custom field
information, if any, and click OK.

If there are manual tests in the group, you will be asked if you want to continue.
Click Yes.
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4. Oracle Test Manager runs the tests in sequence. The Run Manual Test wizard

prompts you through any manual tests. The results are displayed when all tests
have been run.

11.18.4 Deleting Test Results

You can delete test results based on the date and time the test was run.

To delete test results:

1.
2.

Select Delete Test Results from the Actions menu.

Select the results that you want to delete. You can select more than one test result
by clicking on each test result that you want to delete.

Click OK.

11.19 Associating Requirements With Tests

To associate requirements with a test:

1.
2.

Select the test with which you want to associate a requirement.
Select Associate from the Actions menu then select Associate Requirement.

The Associate Requirements dialog box lists all of the requirements in the project

nn

in an expanded tree view. Associated requirements have an "x" in the checkbox in
front of them. It has the following options:

<requirements list> - click requirements to add and delete them from the list of
associated requirements.

OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.
Select All - selects all requirements.

Clear All - deselects all requirements.

Next - moves to the next associated requirement.
Previous - moves to the previous associated requirement.

Select the requirements you want associated with this test. The number of selected
requirements is displayed at the bottom of the window.

Click OK. The requirements will be listed in the right pane under associated
requirements.

11.20 Associating Issues With Tests

To associate issues with a test:

1.
2.

Select the test with which you want to associate an issue.
Select Associate from the Actions menu then select Associate Issues.

The Associate Issues dialog box lists all of the issues in the project in an expanded

nn

tree view using the same grouping as the Issues tab. Associated issues have an "x
in the checkbox in front of them. It has the following options:

<issues list> - click issues to add and delete them from the list of associated issues.

OK - closes the dialog box and saves changes.
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Cancel - closes the dialog box without saving changes.
Select All - selects all issues.

Clear All - deselects all issues.

Next - moves to the next associated issue.

Previous - moves to the previous associated issue.

3. Select the issues you want associated with this test. The number of selected issues
is displayed at the bottom of the window.

4. Click OK. The issues will be listed in the right pane under associated issues.

11.21 Viewing Test Details
You can view the result details for each test run. To view test details:
1. Select the test for which you want to view details.

2. In the Run History section of the right pane, click the date of the test for which
you want to view details.

11.22 Viewing the Results Report

The Results report is displayed in a browser window and gives detailed information
about the test run. To view the Results report:

1. Select the test for which you want to view the report.

2. In the Run History section of the right pane, click the date of the test for which
you want to view the report.

3. Click View Report in the Result Detail Summary section of the right pane.

11.23 Saving Scripts

You can download Visual Script files that have been saved in the Oracle Test Manager
database to your local hard drive. They are saved either in the OTM! workspace of
your Oracle Functional Testing installation directory or a shared directory if one is set
up. To save a script:

1. Select the test whose script you want to save.
2. Click Download Test Script in the Run History section of the right pane.
3. Click OK to close the message box.

11.23.1 Creating a Shared Directory

Shared directories provide the capability to place workspaces and other components of
the repository on a network location that lets multiple installs of Oracle Functional
Testing access Visual Scripts and other common files.

Required files - the following files must be installed in the shared directory:
Authman.dat
Dialogs.dat

Favorites.dat
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Required Sub Directories - the following subdirectories and associated files of the
Repository must be below the shared directory:

\Databank
\Spider
\Monitor
\Reporter

Other Sub Directories - the following other subdirectories must be below the shared
directory:

UserWorkspace(s)!

Locking - Oracle Functional Testing has locking in use for Visual Scripts and .dat files.
If an instance-B of Oracle Functional Testing tries to open a Visual Script that is use by
instance-A of Oracle Functional Testing, instance-B receives a message that the Visual
Script is in use. Authentication, Dialog Manager, and preferences also are locked.

The user cannot Save As the same name as a Visual Script that is in use.

Once the shared directory is set up, use the SharedDir setting in the rsw.ini file to
indicate the directory's location. This setting is located in the [Install] section of the
rsw.ini file. The syntax is:

[Install]

SharedDir=networkdrive: sharedDir

11.24 Working With Schedules

You can create a schedule to automatically run Oracle Functional Testing tests at a
specified time. Once you have created a schedule, you can enable it. Oracle Test
Manager must be running to enable a schedule, although you do not have to be logged
in to a database. The schedule is automatically disabled when you exit Oracle Test
Manager.

11.24.1 Scheduling Tests

To schedule a test:
1. Select the test that you want to schedule.

2. Select Schedule Test from the Actions menu to display the Schedule Test dialog
box.

The Schedule Tests dialog box has the following options:

Database - indicates the database in which the test is located.

Project - indicates the project to which this test belongs.

Test - indicates the name of the test.

Type - select the frequency with which you want to run the test. The options are:
= Once - runs the test one time.

= Daily - runs the test daily at the selected time.

= Weekly - runs the test weekly at the selected date and time.
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= Monthly - runs the test once a month on the selected date and time.

Date - click on the day, month, or year to edit the date or click the down arrow to
display a calendar to select the date.

Time - enter the time at which you want to run the test or click the arrows to
change the time.

Version - enter or select the version.

Enable - enables the test so that it executes when the schedule is enabled. Disabled
tests will not execute.

3. Select the frequency with which you want to run the test.
4. Select the date and time at which you want to run the test.

5. Click OK.

11.24.2 Editing the Schedule
To edit the schedule:

1. Select Schedule from the View menu to display the Schedule dialog box.
The Schedule dialog box has the following options:

Test List - lists the tests in the schedule. You can sort the schedule by any of the
following columns by clicking the column title:

s Test - displays the name of the test.

s Type - displays the type of test.

= Date - displays the date that the test is scheduled to run.

s Time - displays the time that the test is scheduled to run.

= Enabled - indicates whether the test is enabled or disabled.
Close - exits the dialog box.

Edit - displays the Edit Schedule dialog box for the selected test.
Delete - deletes the selected test from the schedule.

Select the test that you want to edit.

Click Edit to display the Edit Schedule dialog box.

Make any changes and click OK.

Click Enable All to enable all tests or click Disable All to disable all tests.
Click Close.

o g k& 0D

11.24.3 Enabling and Disabling the Schedule

Oracle Test Manager must be running for the schedule to execute. You do not have to
be logged in to a database to enable or disable the schedule.

To enable the schedule, select Activate Schedule from the View menu. A check in
front of this option indicates that the schedule is enabled.

To disable the schedule, select Deactivate Schedule from the View menu. A blank in
front of this option indicates that the schedule is disabled.
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11.25 Adding Issues

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

When you add an issue, it is automatically assigned the next available number in the
database and is added at the bottom of the list. This number cannot be changed. You
can group issues using the right-click menu or by selecting Group by from the View
menu. To add an issue:

1.

Select Add from the Actions menu then select Add Issue.
The Add Issue dialog box has the following options:
Summary - enter the title of the issue.

Component - select the component associated with the issue. Components are
entered by your system administrator using the Oracle Application Testing Suite
Administrator.

Assigned To - select the person responsible for the issue. These options can be
changed by your system administrator.

Status - select the issue's status. These options can be changed by your system
administrator.

Priority - select the issue's priority. These options can be changed by your system
administrator.

Severity - select the severity of the issue. These options can be changed by your
system administrator.

Version - select or enter the version of the software that was being tested.

Platform - select or enter the platform on which the issue occurred. These options
can be changed by your system administrator.

Description - enter details about the issue.
Solution - enter details about the issue's resolution.

Attachment - lets you add an attachment to this issue. Click Browse to display the
Open dialog box for selecting the file to attach.

Enter the issue details.

Click OK.

11.26 Deleting Issues

To delete issues:

1.
2.
3.

Select the issue you want to delete.
Select Delete Issue from the Actions menu.

Click Yes when asked to confirm the deletion.
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11.27 Editing Issues

Note: The fields and options available to you may be different than
those shown in the following examples if your system has been
customized by your system administrator.

To edit an issue:

1.
2.

Select the issue you want to edit.

Select Edit Issue from the Actions menu.

The Edit Issue dialog box has the following options:
Summary - enter the title of the issue.

Component - select the component associated with the issue. Components are
entered by your system administrator using the Oracle Application Testing Suite
Administrator.

Assigned To - select the person responsible for the issue. These options can be
changed by your system administrator.

Status - select the issue's status. These options can be changed by your system
administrator.

Priority - select the issue's priority. These options can be changed by your system
administrator.

Severity - select the severity of the issue. These options can be changed by your
system administrator.

Version - select or enter the version of the software that was being tested.
Platform - select or enter the platform on which the issue occurred.

Add Description - enter a new description. This text is appended to previous
description text.

Edit Text - Select this option to display and edit previously entered description
text. The text is displayed when the box is checked.

Add Solution - enter a new resolution. The text is appended to previous solution
text.

Edit Text - Select this option to display and edit previously entered solution text.
The text is displayed when the box is checked.

Attachment - lets you add an attachment to this issue. Click Browse to display the
Open dialog box for selecting the file to attach.

Make any changes.
Click OK.

11.28 Associating Issues With Issues

To associate issues with an issue:

1.
2.

Select the issue with which you want to associate another issue.

Select Associate from the Actions menu then select Associate Issues.
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This dialog box lists all of the issues in the project in an expanded tree view in the
same grouping as the Issues tab. Associated issues have an "x" in the checkbox in
front of them. It has the following options:

<issues list> - click issues to add and delete them from the list of associated issues.
OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Select All - selects all issues.

Clear All - deselects all issues.

Next - moves to the next associated issue.

Previous - moves to the previous associated issue.

Select the issues you want associated with this issue. The number of issues
selected is displayed at the bottom of the window.

Click OK. The issues will be listed in the right pane under associated issues.

11.29 Associating Tests With Issues

To associate tests with an issue:

1.
2

Select the issue with which you want to associate a test.
Select Associate from the Actions menu then select Associate Test.

This dialog box lists all of the tests in the project in an expanded tree view.
Associated tests have an "x" in the checkbox in front of them. It has the following
options:

<test list> - click tests to add and delete them from the list of associated tests.
OK - closes the dialog box and saves changes.

Cancel - closes the dialog box without saving changes.

Select All - selects all tests.

Clear All - deselects all tests.

Next- moves to the next associated test.

Previous - moves to the previous associated test.

Select the tests you want associated with this issue. The number of tests selected is
displayed at the bottom of the window.

Click OK. The tests will be listed in the right pane under associated tests.
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Screen Capture Utility

The Screen Capture program lets you capture the entire screen, windows, and parts of
windows, and then save them in either JPG or BMP format.

The Screen Capture program runs in the system tray. You can access its options either
by clicking on the icon in the system tray to display the main window or by using the
right-click menu.

A.1 Main Window

The Main Window consists of a menu bar and an area for displaying the screen
capture once it is taken. Using the Capture menu, you select the type of screen capture
that you want to take. Once the screen capture is take, you can then save the screen
capture or copy it for pasting into another application.

A.2 Menu Options

The Screen Capture utility has the following menu options:

A.2.1 File Menu

Save As - displays the Save As dialog box for saving the screen capture in either JPG
or BMP format.

Preferences - displays the Preferences dialog box for setting the Screen Capture utility
preferences. You can set whether to integrate with Oracle Test Manager, to display
instructions before capturing an active window, and set the number of seconds to wait
before taking the screen capture.

Close - closes the application but does not remove it from the system tray. To exit the
application, right click the icon in the system tray and select Exit.

A.2.2 Edit Menu

Copy - copies the screen capture to the clipboard so that you can paste it into another
application.

Clear - removes the current screen capture from the Screen Capture utility.

A.2.3 Capture Menu

Entire Screen - captures the entire screen display.

Active Window - captures the active window after a specified number of seconds. The
delay lets you make sure the correct window is active.
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Specific Window - captures the selected portion of a window such as the right or left
pane, toolbar, etc.

Selected Region - changes the cursor to a cross hair and captures the selected area.

A.2.4 Help Menu

Contents - displays the help table of contents.

About - displays version and copyright information.

A.3 Setting Preferences
To change the Screen Capture utility settings:
1. Select Preferences from the File menu to display the preferences dialog box.

Integrate with Oracle Test Manager - when selected, the screen capture utility is
available in Oracle Test Manager. You may want to deselect this setting for
debugging purposes if there is a browser problem.

Display instructions before capturing active window - when selected, a dialog
box is displayed explaining that the active window screen capture will take place
after the configured number of seconds.

Seconds to wait before capturing active window - specifies how long to wait
before capturing the active window. This delay lets you ensure that the correct
window is active and also give you time to click on a menu if you want to include
the menu in the screen capture.

2. Make any changes.
3. Click OK.

A.4 Capturing Screens

The following sections explain the screen capture methods.

A.4.1 Capturing the Entire Screen

To capture the entire screen:
1. Select Entire Screen from the Capture menu.

2. The Screen Capture utility minimizes itself, captures the entire window, and
redisplays.

3. Select Save As from the File menu to display the Save As dialog box. Select where
to save the file, enter a name, and click Save.

Or

Select Copy from the Edit menu to copy the screen capture to the clipboard. You
can then paste it into another application.

4. Select Clear from the Edit menu to remove the screen capture from the utility.

A.4.2 Capturing a Window

You can capture the active window. There is a user-configurable delay or several
seconds between the time you select this option and when the screen capture is taken.
This delay lets you select the active window to capture.
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Note: Some part of the window you want to capture must be visible
on the screen before you select this option since the utility captures the
first window you click on.

To capture an active window:

1.
2.
3.

Select Active Window from the Capture menu.
The Screen Capture utility minimizes itself.

If the Display instructions before capturing active window is selected in
preferences, a dialog box is displayed explaining what the utility will do. Click
OK.

If the active window is not the one you want to capture, click on the window you
want to capture. If you want to capture a menu, expand the menu.

After the delay, the utility captures the window and redisplays.

Select Save As from the File menu to display the Save As dialog box. Select where
to save the file, enter a name, and click Save.

Or

Select Copy from the Edit menu to copy the screen capture to the clipboard. You
can then paste it into another application.

Click Clear from the Edit menu to remove the screen capture from the utility.

A.4.3 Capturing Part of a Window

You can capture just part of a window such as a right or left pane or toolbar. To capture
part of a window:

1.
2.
3.

Select the window that you want to take a partial screen shot of.
Select Specific Window from the Capture menu.
The Screen Capture utility minimizes itself.

You can move the mouse around the window to see the part that can be captured.
Select the part of the window you want to capture.

The utility captures the window and redisplays.

Select Save As from the File menu to display the Save As dialog box. Select where
to save the file, enter a name, and click Save.

Or

Select Copy from the Edit menu to copy the screen capture to the clipboard. You
can then paste it into another application.

Click Clear from the Edit menu to remove the screen capture from the utility.

A.4.4 Capturing a Region

You can capture a user-selected region of the screen. To capture a region:

1.
2.
3.

Select the window that you want to take a partial screen shot of.
Select Region from the Capture menu.

The Screen Capture utility minimizes itself and the cursor becomes a cross hair.
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4. Click and drag to select the part of the screen you want to capture.
5. When you release the mouse, the utility captures the window and redisplays.

6. Select Save As from the File menu to display the Save As dialog box. Select where
to save the file, enter a name, and click Save.

Or

Select Copy from the Edit menu to copy the screen capture to the clipboard. You
can then paste it into another application.

7. Click Clear from the Edit menu to remove the screen capture from the utility.
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